The Amarok Handbook

This documentation was converted from the KDE UserBase Amarok/Manual page.
Contents

1 Amarok: Rediscover your music! 14

2 Quick Start Guide 15
  2.1 Getting started .............................................. 16
    2.1.1 Starting Amarok ...................................... 16
      2.1.1.1 From Plasma .................................. 16
      2.1.1.2 From the file manager ......................... 16
    2.1.2 First Time ........................................... 16
    2.1.3 Closing Amarok ..................................... 17
  2.2 The Amarok window ...................................... 18
    2.2.1 Default layout of the Amarok window ............ 18
    2.2.2 Using the Amarok window to manage and play your music .. 19
  2.3 The Music Collection ................................... 19
    2.3.1 The Media Sources pane ............................. 19
    2.3.2 Setting up a collection .............................. 20
    2.3.3 Adding Media Devices to the Collection .......... 20
    2.3.4 Ripping a CD into the collection .................. 21
    2.3.5 Accessing other media sources .................... 22
    2.3.6 Streams and Podcasts ............................... 24
    2.3.7 Using the Content Browser ......................... 24
      2.3.7.1 Hiding or expanding information ............... 24
      2.3.7.2 Changing the order of tracks and albums ... 25
      2.3.7.3 Deleting items from the collection .......... 26
  2.4 Playlists .................................................. 26
    2.4.1 The Playlist pane ................................... 26
    2.4.2 Adding music to a playlist ......................... 27
    2.4.3 Using the Toolbar .................................... 28
    2.4.4 Manipulating playlists .............................. 28
      2.4.4.1 Removing a track .............................. 28
      2.4.4.2 Using the Playlist tools at the bottom ....... 29
    2.4.5 Saving and retrieving your favorite playlists .... 30
# The Amarok Handbook

## 2.5 The Context View

2.5.1 Default layout ................................................. 31
2.5.2 Customizing the Context pane .............................. 32

## 2.6 How to deal with problems

2.6.1 Some of the music is being rapidly skipped over ........ 32
2.6.2 After my iPod has been mounted, it is not shown in the Content Browser ................................................. 33
2.6.3 After I have updated my collection, the additions are not shown in the Content Browser ................................................. 33
2.6.4 Amarok cannot find the lyrics of the songs that I play ... 33
2.6.5 My question isn’t answered here ............................ 33

## 2.7 Glossary

2.7.1 Breadcrumbs .................................................. 33
2.7.2 Collection .................................................... 33
2.7.3 Collection Browser ......................................... 34
2.7.4 Playlist ....................................................... 34
2.7.5 Script ........................................................ 34
2.7.6 Scrobble ...................................................... 34
2.7.7 Stream, streaming ........................................... 34
2.7.8 Tags .......................................................... 34

## 3 The Amarok Window

3.1 Window Layout .................................................. 35
3.2 Toolbar .......................................................... 37
3.2.1 Introduction .................................................. 37
3.2.2 Main Toolbar ................................................ 38
3.2.3 Slim Toolbar ................................................ 38
3.3 The Media Sources pane ...................................... 38
3.3.1 Navigation Menu .......................................... 39
3.3.1.1 The Filter Bar ........................................ 39
3.3.1.2 Bookmarks ........................................... 39
3.3.2 Local Music ................................................ 40
3.3.3 Internet ...................................................... 41
3.3.4 Playlist ...................................................... 42
3.3.5 Files ........................................................ 42
3.3.6 Podcasts ..................................................... 43
3.4 The Context pane ............................................... 44
3.4.1 Using the Context pane .................................... 44
3.4.1.1 Configuring Applets .................................. 45
3.4.2 Applets ....................................................... 45
3.5 The Playlist pane ............................................... 46
3.5.1 Basic Playlist Manipulation ............................... 47
3.5.2 Context menu ............................................. 48
The Amarok Handbook

3.5.2.1 Queue/Dequeue Track ........................................... 48
3.5.2.2 Stop Playing After This Track ................................. 48
3.5.2.3 Remove From Playlist ........................................... 49
3.5.2.4 Add Position Marker ............................................ 49
3.5.2.5 Show in Media Sources ........................................ 49
3.5.2.6 Album ............................................................. 49
3.5.2.7 Edit Track Details ............................................... 49
3.5.3 Searching the Playlist ............................................. 50
3.5.4 Sorting Levels and Bookmarking ................................... 50
3.5.4.1 Sorting Levels .................................................. 51
3.5.4.2 Bookmarking .................................................... 51
3.5.5 Playlist Functions .................................................. 52
3.5.5.1 Save Playlist menu ............................................. 53
3.5.5.2 Track Progression .............................................. 53
3.5.5.2.1 Favor ......................................................... 54
4 Configuring Amarok ....................................................... 55
4.1 General ................................................................. 55
4.2 Local Collection ....................................................... 56
4.2.1 Import Statistics ................................................... 57
4.3 Metadata ............................................................... 57
4.3.1 Statistics Synchronization .......................................... 58
4.4 Playback ............................................................... 59
4.4.1 Configuring Phonon ............................................... 60
4.4.1.1 Device Preference tab ........................................... 60
4.4.1.2 Speaker Setup tab .............................................. 61
4.4.1.3 Backend tab .................................................... 61
4.5 Notifications .......................................................... 62
4.6 Database ............................................................... 63
4.7 Plugins ................................................................. 64
4.7.1 Collections ........................................................ 64
4.7.2 Internet Services .................................................... 65
4.7.3 Local Collection Backends ........................................ 65
4.7.4 Ampache configuration ........................................... 65
4.7.5 Last.fm configuration .............................................. 66
4.7.6 Magnatune Store configuration .................................. 66
4.7.7 MP3 Store configuration .......................................... 66
4.7.8 mp3tunes configuration ........................................... 66
4.8 Scripts ................................................................. 67
4.8.1 Generic scripts ...................................................... 67
4.8.2 Lyrics scripts ....................................................... 67
4.8.3 Scriptable Services scripts ........................................... 67
4.8.4 Manage Scripts ......................................................... 67
   4.8.4.1 Add-on Installer ................................................. 68
   4.8.4.2 Script Information ............................................. 68
4.9 Changing Layouts .......................................................... 69
   4.9.1 Changing the Amarok Window Layout ......................... 69
      4.9.1.1 Undocking Amarok panes ................................ 69
      4.9.1.2 Lock and save Amarok window layout ................ 70
   4.9.2 Changing the Toolbar ............................................. 70
   4.9.3 Changing the Playlist layout .................................. 71
      4.9.3.1 Modifying a default layout ............................... 71
         4.9.3.1.1 Item layout configuration .......................... 71
         4.9.3.1.2 Example: single line layout ....................... 72
         4.9.3.1.3 Playlist layout storage ............................. 72
5 Organization ............................................................... 73
   5.1 Collection ............................................................ 73
      5.1.1 Collection Scanning .......................................... 74
         5.1.1.1 Incremental Scan / Update Collection ................ 74
         5.1.1.2 Progress bar / scanning time .......................... 75
         5.1.1.3 Backup of collection ..................................... 75
         5.1.1.4 About unique ids ....................................... 75
         5.1.1.5 About Albums ............................................ 75
      5.1.2 Search in Collection .......................................... 76
         5.1.2.1 Edit Box .................................................. 76
         5.1.2.2 Tags ....................................................... 77
         5.1.2.3 Additional searchable fields ......................... 77
         5.1.2.4 Operators ............................................... 77
         5.1.2.5 Examples ............................................... 78
      5.1.3 Edit Filter Dialog ............................................. 78
      5.1.4 Organize Collection ........................................... 79
         5.1.4.1 Organizing Files Interface ............................. 80
         5.1.4.2 Contents ................................................ 81
         5.1.4.3 Advanced Contents .................................... 82
      5.1.5 Statistics Synchronization Between Collections and with Last.fm 83
         5.1.5.1 Manual Syncing .......................................... 83
            5.1.5.1.1 Conflicts and Syncing Statistics Dialog ......... 83
         5.1.5.2 Synchronizing with Last.fm ............................ 84
            5.1.5.2.1 Spelling Auto-Correction ....................... 84
         5.1.5.3 Unattended Syncing .................................... 85
5.1.6 Remote Collections ................................................. 86
  5.1.6.1 Ampache .................................................... 86
  5.1.6.2 Ampache Client ............................................. 87
  5.1.6.3 Digital Audio Access Protocol (DAAP) ...................... 88
  5.1.6.4 Client ..................................................... 88
  5.1.6.5 Samba .................................................... 89
  5.1.6.6 Client ..................................................... 89
  5.1.6.7 Server .................................................... 89
  5.1.6.8 Universal Plug and Play (UPnP) / DLNA .................... 90
5.1.7 External Database .................................................. 91
  5.1.7.1 Install MySQL-Server .................................... 92
  5.1.7.2 Configure Database ........................................ 92
  5.1.7.3 Configure Client ........................................... 92
  5.1.7.4 Migrating from MySQL Embedded to MySQL Server ....... 93
5.1.8 Working with Media Devices ........................................... 94
  5.1.8.1 Connecting Media Devices ................................ 94
  5.1.8.2 Play Music from the Media Device ......................... 94
  5.1.8.3 Managing the Media ....................................... 96
  5.1.8.4 Troubleshooting Media Device support .................... 96
5.2 Cover Manager ......................................................... 97
  5.2.1 Browsing Covers ............................................... 97
  5.2.2 Fetching Missing Covers ..................................... 98
  5.2.3 Changing Cover Art ........................................... 98
5.3 Tag Editor ............................................................ 98
  5.3.1 Edit Tags Manually ............................................ 99
    5.3.1.1 Tags ..................................................... 99
    5.3.1.2 Edit Single Track ....................................... 99
    5.3.1.3 Edit Several Tracks .................................... 100
    5.3.1.4 All At Once ............................................. 100
    5.3.1.5 Track By Track ......................................... 101
  5.3.2 Get Tags from MusicBrainz .................................... 101
  5.3.3 Guess Tags From Filename .................................... 102
    5.3.3.1 Options ................................................ 102
    5.3.3.2 Basic .................................................. 103
    5.3.3.3 Example ............................................... 103
    5.3.3.4 Advanced ............................................ 104
    5.3.3.5 Example ............................................... 104
5.4 Transcoding .......................................................... 105
  5.4.1 Interface ...................................................... 105
  5.4.2 Transcode Tracks Dialog ..................................... 105
  5.4.3 Custom Encoding ............................................. 106
  5.4.4 Saving Transcoding Preferences ............................... 106
  5.4.5 Pro Tip: Strip Audio out of Video Files ...................... 107
5.5 Script Manager ........................................................ 107
6 Playlist

6.1 Saved Playlists ................................................................. 108
  6.1.1 Managing saved playlists ........................................... 109
    6.1.1.1 Saving a Playlist ................................................ 109
    6.1.1.2 Exporting a Playlist ............................................. 109
    6.1.1.3 Importing a Playlist ............................................. 109
  6.2 Playlist Filtering ....................................................... 110
    6.2.1 Edit Box ............................................................... 110
      6.2.1.1 Examples .......................................................... 110
    6.2.2 Search Preferences ................................................ 110
      6.2.2.1 Check boxes ...................................................... 111
      6.2.2.2 Show only matches - example .................................. 111
  6.3 Queue Manager ............................................................ 112
    6.3.1 How to Create a Queue .............................................. 112
      6.3.1.1 Example ........................................................... 112
    6.3.2 How to Edit the Queue .............................................. 113
      6.3.2.1 Queue Editor ...................................................... 114
  6.4 Dynamic Playlists ....................................................... 114
    6.4.1 How the Dynamic Playlist works ................................... 115
    6.4.2 Using a Dynamic Playlist ......................................... 115
    6.4.3 Defining Dynamic Playlists ..................................... 115
      6.4.3.1 Biases ............................................................. 116
    6.4.4 A dynamic playlist in use ....................................... 117
    6.4.5 Using your Dynamic Playlist .................................... 117
    6.4.6 A dynamic playlist in use ....................................... 118
  6.5 Automatic Playlist Generator ......................................... 118
    6.5.1 APG Presets Toolbar ................................................ 118
    6.5.2 Working with Presets .............................................. 119
      6.5.2.1 Constraints ....................................................... 119
      6.5.2.2 Constraint Types ............................................... 119
      6.5.2.3 Constraint Groups .............................................. 120
    6.5.3 Using your Presets ................................................ 120

7 Various ............................................................................. 122

7.1 The Moodbar ................................................................. 122
  7.1.1 Summary of Requirements .......................................... 123
  7.1.2 Usage ........................................................................ 123
  7.1.3 Installation ............................................................... 123
    7.1.3.1 Source Downloads .................................................. 123
    7.1.3.2 Debian packages .................................................... 123
    7.1.3.3 Kubuntu and Ubuntu packages ............................... 124
The Amarok Handbook

7.1.3.4 Gentoo ebuilds ............................................. 124
7.1.3.5 RPM builds ................................................. 124
7.1.3.6 Fedora ..................................................... 124
7.1.3.7 openSUSE packages ........................................ 125
7.1.3.8 Mandriva packages ........................................ 125
7.1.3.9 Arch Linux® ............................................... 125
7.1.3.10 FreeBSD ................................................... 125
7.1.4 Moodbar File Generation Script ............................ 126
7.1.5 Troubleshooting ............................................... 127
7.1.6 Supported Filetypes .......................................... 127
7.1.7 Screenshots .................................................... 128
7.2 Replay Gain ....................................................... 128
7.2.1 Is replay gain being used? ................................. 128
7.2.2 View replay gain information ............................. 128
7.2.3 Delete replay gain information ............................ 129
7.3 Amarok on other platforms .................................... 129
7.3.1 Amarok on Non-KDE Desktops .............................. 130
7.3.1.1 GNOME .................................................. 130
7.3.1.2 Enlightenment .......................................... 131
7.3.1.3 XFCE ..................................................... 131
7.3.1.4 Fluxbox .................................................. 132
7.3.1.5 LXDE ..................................................... 132
7.3.2 Amarok on Windows .......................................... 132
7.3.2.1 How to download ......................................... 133
7.3.2.2 How to install ............................................. 133
7.3.2.2.1 Step 1 ............................................... 133
7.3.2.2.2 Step 2 ............................................... 133
7.3.2.2.3 Step 3 ............................................... 134
7.3.2.2.4 Step 4 ............................................... 134
7.3.2.3 Running Amarok .......................................... 135
7.3.3 Amarok on Mac® OS X ....................................... 135
7.3.3.1 Installation using MacPorts ............................. 135
7.3.3.2 Screenshots .............................................. 136
7.3.3.3 Other resources ......................................... 136
7.4 Troubleshooting and Common Problems ....................... 137
7.4.1 Problems installing ......................................... 137
7.4.1.1 Bad packaging ......................................... 137
7.4.1.2 Difficulties building from source ...................... 137
7.4.2 Problems starting up ....................................... 137
7.4.2.1 Playlist errors ......................................... 137
7.4.2.2 Database issues ....................................... 137
Chapter 7: Troubleshooting and FAQs

7.2 Troubleshooting

7.2.1 Other issues and backing up settings

7.2.2 Problems Scanning, Sorting files

7.2.2.1 Corrupt tags

7.2.2.2 Inability to write tags

7.2.2.3 Incorrect Sorting (Various Artists)

7.2.2.4 Duplicate Tracks

7.2.3 Problems playing files

7.2.3.1 Amarok skips over tracks, or appears to play them without sound

7.2.3.2 No sound, or bad sound

7.2.4 Problems with collections on iPod etc.

7.2.4.1 Amarok show no cover-images or images are lost when transferring to device

7.2.5 Crashes and bugs

7.3 Frequently Asked Questions

7.3.1 What is Amarok?

7.3.2 What are the differences between Amarok 2 and the previous versions?

7.3.3 Installation

7.3.3.1 Can I use Amarok without KDE?

7.3.3.2 Why does Amarok use KDElibs?

7.3.4 General usage

7.3.4.1 How can I control Amarok from the keyboard?

7.3.4.2 Where can I get support for Amarok?

7.3.4.3 How do I report a bug?

7.3.5 Questions about the Playlist

7.3.5.1 When I start Amarok, I see an empty playlist. How do I actually get tracks in there?

7.3.5.2 How do I remove tracks from the Playlist?

7.3.5.3 How can I load a playlist?

7.3.5.4 How can I save the current playlist?

7.3.6 Playback Questions

7.3.6.1 How do I play audio CDs?

7.3.6.2 What media types does Amarok support?

7.3.6.3 What is Phonon? What are Phonon backends?

7.3.6.4 Amarok won’t play mp3s, what can I do?

7.3.6.5 I have the codecs, but Amarok still won’t play mp4s and mkas

7.3.6.6 I have a second soundcard and I’m using ALSA. How do I make Amarok use it instead of the default?

7.3.6.7 Where’s the equalizer?

7.3.6.8 How can I control the volume in Amarok only without having to change in KMix?

7.3.6.9 How do I turn on visualizations?
The Amarok Handbook

7.5.6.10 How can I add podcasts? .................................................. 144
7.5.6.11 How can I use Amarok to stream to my own radio station? ... 144

7.5.7 Collection questions .............................................................. 145
7.5.7.1 Folder not properly picked up .............................................. 145
7.5.7.2 Can I use removable media inside Amarok? ......................... 145
7.5.7.3 Can I use the old Amarok’s collection in Amarok 2? Will my tags,
    score are ratings be lost? ........................................................ 145

7.5.8 General questions ................................................................. 145
7.5.8.1 What are scripts? .............................................................. 145
7.5.8.2 Can I use Amarok 1.4 scripts in Amarok 2? ......................... 145
7.5.8.3 What are Moodbars? ......................................................... 146
7.5.8.4 Can I play video files? ....................................................... 146
7.5.8.5 Is it Amarok, AmaroK or amaroK? ...................................... 146
7.5.8.6 How are track scores determined? ...................................... 146
7.5.8.7 How do I manually change a track’s score? ......................... 146
7.5.8.8 But I also want that stars system like in other players! .......... 146
7.5.8.9 Can I drag and drop Plasma applets from the main window to
    the Desktop? ........................................................................ 146
7.5.8.10 How can I save a stream? .................................................. 147
7.5.8.11 Where do I find the settings for Amarok? ......................... 147

7.5.9 Troubleshooting ............................................................. 147
7.5.9.1 How can I obtain a backtrace? ............................................. 147
7.5.9.2 Amarok just freezes! How can I help get this fixed? ............. 147
7.5.9.3 Amarok takes a lot of time to start ...................................... 147

7.5.10 Development questions ...................................................... 147
7.5.10.1 How do I get a GIT version of Amarok? .............................. 147
7.5.10.2 Why isn’t Amarok part of KDE Multimedia? ...................... 147
7.5.10.3 I’ve found a bug / I’ve got a great idea for Amarok! ............. 148
7.5.10.4 Do you accept patches? .................................................... 148
7.5.10.5 Why did you choose the name Amarok? ............................. 148

8 References ........................................................................ 149

8.1 Menu and Command Reference ................................................. 149
8.1.1 Amarok Top-level Menus ...................................................... 149
8.1.2 Amarok Menu .................................................................. 150
8.1.3 Contents ........................................................................ 150
8.2 View Menu ........................................................................ 151
8.2.1 Changing the Amarok Toolbar ............................................ 151
8.2.2 Amarok Window Layouts .................................................... 151
8.2.3 Playlist Menu ................................................................... 155
8.2.3.1 Menu Items ................................................................ 155
8.2.3.2 Playlist Layouts .......................................................... 156
Abstract

Amarok is a free, versatile and powerful music player for Linux®. The latest 2.x release series, often referred to as ‘Amarok 2’, is cross-platform (can be used on many platforms, including Linux®, Mac® OS and Microsoft® Windows®) and implements a completely reworked code base that will enable it to incorporate exciting new features as the release matures. The current stable release is version 2.4.
Amarok: Rediscover your music!

Amarok is the premier Free, Open Source Music application. More than simply a music player, Amarok helps you rediscover your music. The innovative interface gives you unprecedented control over your collection, and extends your reach to music everywhere. Use our Quick Start Guide to get going quickly, or search out more in-depth information in this handbook.
Chapter 2

Quick Start Guide

Congratulations on installing Amarok, the most advanced music discovery software available. Amarok will help you explore your music, and enjoy it as never before. Also, you can tour different sources of music, radio stations and audio books online. In this guide, we’ll show you how to let Amarok find your collection, play it for you, and also how to use Amarok to find things online. We’ll assume that you know nothing about Amarok, but do know how to use menus, a mouse, and your keyboard.

1. Getting started
   (a) Starting Amarok
   (b) Closing Amarok

2. The Amarok window
   (a) Default layout of the Amarok window
   (b) Using the Amarok window to manage and play your music

3. The Music Collection
   (a) The Media Sources Pane
   (b) Setting up a collection
   (c) Adding Media Devices to the Collection
   (d) Ripping a CD into the collection
   (e) Accessing other media sources
   (f) Streams and Podcasts
   (g) Using the Content Browser
      i. Hiding or expanding information
      ii. Changing the order of tracks and albums
      iii. Deleting items from the collection

4. Playlists
   (a) The Playlist pane
   (b) Adding music to a playlist
   (c) Using the Toolbar
   (d) Manipulating playlists
      i. Removing a track
      ii. Using the Playlist tools at the bottom
The Amarok Handbook

5. The Context View
   (a) Default layout
   (b) Customizing the Context pane

6. How to deal with problems

7. Glossary

2.1 Getting started

2.1.1 Starting Amarok

If you already know your way around your operating system, you probably also know how to start Amarok, and you can continue. Else, continue reading.

2.1.1.1 From Plasma

If you are running the Plasma Workspace, you can start Amarok by either:

• pressing on Kickoff and then Multimedia → Amarok.
• invoking KRunner (Alt-F2 by default), entering amarok and then pressing Enter.

2.1.1.2 From the file manager

Open a multimedia file that Amarok is known to play.

2.1.2 First Time

The first time you use Amarok, a dialog box will come up asking you to specify your locale:

![Amazon Store Service Config dialog box]
The Amarok Handbook

Next, a First Start dialog box will come up asking you to specify where your music is located. If you have a music directory already configured in your system, Amarok should detect it and ask you to use it:

If you select No in this dialog, you will be presented with another one which allows you to select your music folder:

See Setting Up a Collection

Once you have selected the folder where your music is, Amarok will scan the folder and subfolders, creating the collection. This can take some time, depending on the number of tracks and the speed of the location.

2.1.3 Closing Amarok

If you want to close Amarok:

- Type Ctrl-Q when you are in the Amarok window, or
- Select the Quit option in the Amarok menu, or
- Right-click on the blue wolf icon in the System Tray at the bottom of your screen. You will be presented with the following:
If you close the Amarok window by clicking **Close** on the window border, Amarok will continue to run in the background and only show the blue wolf icon in the **System Tray**:

If you log out of your session or shut down your computer without quitting Amarok, some of your settings will not be saved.

### 2.2 The Amarok window

The Amarok window is designed to let you rediscover your music. So, it gives you as much information about your music as possible. While many users will enjoy the default layout, it is fully customizable.

#### 2.2.1 Default layout of the Amarok window

Upon installation, Amarok will look like this:
The Amarok Handbook

Amarok 2.8, newly installed

The Amarok window has four main parts:

1. under the top-level menus is the Toolbar which lies above three panes:
2. your Media Sources (music collection and other media) in the left pane,
3. the Context pane in the center, and
4. the Playlist in the right-hand pane.

2.2.2 Using the Amarok window to manage and play your music

Playing music using Amarok usually takes two steps:

1. Create a playlist by selecting some of the tracks in your collection, which you will find listed in the Media Sources pane, and send your music to the Playlist pane.
2. Play the music in your playlist, using the Playlist pane and/or the Toolbar.

Also, you may want to transfer some of your music to a mobile music player, such as an iPod. The next sections will explain how.

2.3 The Music Collection

2.3.1 The Media Sources pane

The Media Sources pane is the place where you browse and display your complete collection of music. This includes the tracks on your local hard disk, as well as those on any external devices or media connected to your computer, such as audio CD, USB devices, media players, network disks or Internet sources.
2.3.2 Setting up a collection

Do you have music tracks in *mp3*, *Ogg* or *FLAC* format on your computer? Begin by telling Amarok where to find those files, so it can create your collection. In the top-level menu: **Settings → Configure Amarok → Local Collection.**

![Configure Collection Dialog, as of version 2.8](image)

A tree-view of your home directory is shown above. Click the check box where your music is stored; usually **home → Music**. Then choose **Fully Rescan Entire Collection**. This will take some time, so do not be alarmed if Amarok seems slow for a while. Once the scan is complete, it is best to quit Amarok using the top-level Amarok menu, or **Ctrl-Q**, and then restart it. Your newly-added music should show up under the **Local Collection** section.

More about configuring your collection [here](#).

**TIP**
The set of multimedia formats recognized by Amarok is not restricted to those mentioned above; is controlled by the **Phonon** back end.

2.3.3 Adding Media Devices to the Collection

Underneath the search bar near the top of the **Media Sources** pane you see the different devices and/or content categories within the **Content Browser**. If you insert an Audio CD in the CD drive it will appear in the **Media Sources** pane, along with media players, thumb drives, and other USB devices. After an external device has been mounted, it will show automatically within the **Media Sources** pane.

Below is a screenshot showing three connected sources with music: Audio CD, mp3 player, and the **Local Collection**.
2.3.4 Ripping a CD into the collection

If you don’t have any music files on your computer, it’s easy to rip them (copy the tracks from your CDs to your collection). Just pop in a CD, and right-click on the banner of the CD device in the Content Browser to play, or copy to your collection, which will rip and tag your tracks (see image below). If you copy music from an audio CD to your Local Collection, the message bar at the bottom of the Amarok window will indicate that it is busy copying. The ripping may take several minutes. Once the rip is complete, the message in the message bar disappears and the music appears in the content browser of your Local Collection. If the ripped music does not appear in your Media Sources pane it’s best to quit Amarok from the Amarok top-level menu, or Ctrl-Q, and then restart it. Now you should see it in your collection. The screenshot below shows how you move tracks from your audio CD, iPod or other device to your collection, using the context (right-click) menu.
In the above context menu, you can also see the choice to **Edit Track Details**. Use this option if you have a track that needs a tag edited. This becomes important when you rip music to .WAV format, losing some of the tags. If quite a bit of your collection needs tagging, consider dedicated tagging software, such as

- Picard
- EasyTag
- Kid3

Correct tagging is important to help Amarok show your tracks in the appropriate albums and proper sort order. Learn more about **ripping and tagging**.

### 2.3.5 Accessing other media sources

You might have wondered why the **Media Sources** pane is not called the ‘Collections’ pane. Amarok gives you access to much more music than just your collection -- Internet shops, audio books, podcasts, music files stored outside your collection, and previously stored playlists. The Amarok **breadcrumb navigation** is the key to all of this. The starting icon for the breadcrumb navigation is the home folder icon at the extreme top left of the **Media Sources** pane. This icon expands and contracts as you browse through the **Media Sources** pane, allowing you to easily navigate your collection by clicking your desired folder in the breadcrumb bar.

If you click the Amarok home folder you see the **Media Sources** pane on the left below, containing icons to available resources. If you click **Files** (left image below, second item from the bottom),
you will see something similar to the image on the right, below. Notice how the breadcrumb bar expands and how the content of the selected folder is shown in the Media Sources pane (right image below). Clicking the > symbols among the breadcrumbs allows you to view the folders available at that level of the folder structure. The Amarok file browser gives you access to your entire file system, even outside your Local Collection.

<table>
<thead>
<tr>
<th>Media Sources pane</th>
<th>Files icon clicked</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Media Sources pane" /></td>
<td><img src="image2" alt="Files icon clicked" /></td>
</tr>
</tbody>
</table>

The functions of the icons in the Amarok Home folder (left above) are:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Local Music" /></td>
<td>Local Music</td>
<td>Your Amarok collection</td>
</tr>
<tr>
<td><img src="image4" alt="Internet" /></td>
<td>Internet</td>
<td>Internet shops such as Magnatune, Jamendo and Last.fm. First configure your internet resources in: Settings → Configure Amarok → Internet Services</td>
</tr>
<tr>
<td><img src="image5" alt="Playlists" /></td>
<td>Playlists</td>
<td>Saved playlists -- see also Playlists. Also playlists on media devices</td>
</tr>
<tr>
<td><img src="image6" alt="Files" /></td>
<td>Files</td>
<td>Your file system</td>
</tr>
<tr>
<td><img src="image7" alt="Podcasts" /></td>
<td>Podcasts</td>
<td>Access to Podcasts via RSS feed</td>
</tr>
</tbody>
</table>
Clicking **Local Music** in the root of **Media Sources** (image above) or in the breadcrumb bar returns you to your collection, showing you a list of all the available resources, artists, albums and tracks that you have previously defined as part of your collection. The breadcrumb bar indicates that you are viewing **Local Music**.

### 2.3.6 Streams and Podcasts

There are two ways to listen to streams.

- If you have a favorite station, get the stream URL and add it: **Playlist → Add Stream**. If you then save your playlist, later you can find it again in **Playlists**, as a **Saved Playlist**.

- Browse through the scripts available in our **Script Manager**, **Tools → Script Manager** up to Amarok 2.4.0, after 2.4.1 **Settings → Configure Amarok → Scripts**. There are some excellent collections available, which will show up in the **Internet** section of your **Media** pane.

Podcasts have their own section in the **Media pane**, above. If you have an RSS or Atom feed URL, click the ![RSS feed icon](image) and add it there. If you have an OPML file to import, that choice is available also. Use the context (right-click) menus to **Add to playlist, Configure, Remove Subscription, Update Channel**, or mark an episode as **New**. If you are interested in browsing through a large collection of podcasts, check out the **Podcast Directory** available through the **Script Manager**, referred to above.

More about configuring **Amaroks Internet Services** here.

### 2.3.7 Using the Content Browser

The hard disk of your computer, audio CDs, external devices and the Internet are the basic resources for your collection. After your collection has been set up, it is likely that your collection will hold a large number of albums and tracks, much more than can be shown on a single window.

How to change the display of your collection, below:

#### 2.3.7.1 Hiding or expanding information

The area of the **Media Sources** pane below the search bar is called the **Content Browser**. Three media sources are indicated in the image of a **Content Browser** below: CD, Local Collection and a Media Player:
Clicking the banner for a device (the blue bar for the Sansa above) shows or hides the content of that device. The direction of the arrow on the right indicates whether the contents for that device is hidden or shown. The content on a particular device can, in turn, be hidden or shown using the same principle, clicking on the appropriate artist or album. An arrow pointing down on the left of an artist or an album indicates that the contents has been expanded. An arrow pointing right indicates that more content for that category is available but currently hidden. In the image above, the information for Mike Oldfield - The Songs of Distant Earth CD has been expanded, showing the individual tracks. On the other hand, the albums and tracks in the Local Collection are hidden. By clicking these arrows you also can expand or hide information.

2.3.7.2 Changing the order of tracks and albums

The order in which tracks are sorted in the Content Browser can be customised by using the button at the top of the Media Sources pane:
The sort order is indicated on the top left of the Media Sources pane, just below the Search text box. The default order is Artist / Year - Album. The display order of the Content Browser can be temporarily switched between the user-defined sort order (described above) and a Merged view in which artists are listed alphabetically, no matter on which media the music is stored. To toggle the Merged view, click the icon at the top right-hand of the Media Sources pane:

To search your collection, type your search term into the Search bar at the top of the Local Music section. Not only can you search by artist, album or track name, but any part. You might create a nice playlist by searching for winter, for instance, or merely find a track when you only remember one word of the title. You can also search by rating, playcount, even filetype. See Search in Collection for more details.

2.3.7.3 Deleting items from the collection

You can delete any item from your collection by right-clicking on it and choosing the bottom item Move Tracks to Trash. A confirmation dialog will appear, preventing the accidental deletion of any tracks. More than one item can be selected with Ctrl-click.

2.4 Playlists

2.4.1 The Playlist pane

Now that Amarok has scanned your collection of music, you want to listen to it. So use the Playlist pane to create a playlist containing the selection of tracks you want. This is where you play your music, streams, or podcasts.

You can sort your playlist by title, album, artist, genre and many others. For instance you can sort your tracks by year first, then by artist and so on.
The Amarok Handbook

The search box lets you search or filter your tracks. The and icons near the top of the Playlist pane lets you skip to the next or previous track containing the letters you have chosen. The button lets you filter your tracks by artist, album, etc.

The layout of the Playlist can be changed through the top-level menu: Playlist → Playlist Layouts.

2.4.2 Adding music to a playlist

There are five ways to add music to the playlist.

1. Choose some of your music in the content browser and drag it to the right. If you drag it over the Context pane you will see the Pop-Up Dropper, also known as PUD. The image above shows PUD in action. PUD provides three options: Add to Playlist, Replace Playlist, and More... The option highlighted in the gray area (Add to Playlist in this image) is the active one. Dropping the album there adds it to the playlist in the Playlist pane. Choose one of the other options to do something else with your selection. Dragging it over More... brings up a new menu of choices in PUD.

2. Drag your selection all the way onto the Playlist pane on the right-hand side of the Amarok screen.

3. Double-click the album/track to append to the playlist, doesn’t start to play.

4. Middle-click the album/track to append it to the playlist and play immediately.

5. Right-click the album or track. In your right-click menu, you will find similar choices. The image below shows the context menu that appears after an item has been right-clicked. Select Add to Playlist.
2.4.3 Using the Toolbar

The Toolbar at the top of the Amarok screen provides a simple interface to control the playing of music in the Playlist.

Click the round icon on the left to start your music playing, and click it again to pause. On the right is the volume and mute control; click on the center of the icon to mute. Use your mouse scroll wheel to control the volume, or drag/click your mouse on the outside ring of the volume icon.

Once a track or stream begins to play, the Artist / Album / Track title slowly alternates in bold in the center. On the right is the next track, which you can click to start it playing immediately. Once a track has played it will be on the left, so you can click on the title to go back to it. The progress bar in the middle of the Toolbar indicates the time elapsed (left hand) and time remaining (right hand) for the track that is currently playing.

If you’d rather see a more traditional toolbar, you can select Slim Toolbar from the View menu.

2.4.4 Manipulating playlists

You may want to delete albums or tracks from your playlist, rearrange the displayed items for each track or rearrange the display order of tracks.

2.4.4.1 Removing a track

You can remove any track or album from your playlist by:

1. Right-click on the item in the playlist and choose the option Remove from playlist.
2. Drag the item to be deleted over the Context pane to activate PUD. Several options will appear over the Context pane. Drag the item to the area marked **Delete from playlist**. See the image below that shows a track being dragged onto the **Remove** option in PUD.

3. Selecting the track or tracks and use your **Delete** key. Multiple tracks can be selected using **Shift** or **Ctrl**.

---

**Pop-up Dropper when removing a track**

Undo your delete by pressing **Ctrl-Z** or by clicking the arrow in the **Playlist Toolbar** at the bottom of the **Playlist** pane (see below).

### 2.4.4.2 Using the Playlist tools at the bottom

At the bottom of the **Playlist** pane are seven icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Clear Playlist" /></td>
<td>Clear playlist of all albums and tracks.</td>
</tr>
<tr>
<td><img src="image.png" alt="Save Playlist" /></td>
<td>Save your playlist. If you do not rename, saves the date as a name.</td>
</tr>
<tr>
<td><img src="image.png" alt="Undo" /></td>
<td>Undo your last edit to playlist.</td>
</tr>
</tbody>
</table>
2.4.5 Saving and retrieving your favorite playlists

The disk icon, in the popup which can be called from the bottom of your Playlist pane, allows you to save the current Amarok playlist. This enables you to recall a particular selection of music from your collection at any time. Playlists only contain pointers to the music you selected, not the music itself. So if your playlist is pointing to music on an external device, it must be connected and mounted, otherwise the music cannot be played. There are three places to store playlists:

1. outside Amarok on your computer file system,
2. in your Amarok playlist database
3. on an portable media device.

Clicking the disk icon at the bottom of the Playlist pane stores your playlist in the Amarok playlist database. To save to disk, click and hold, then scroll to that choice.

These buttons provide convenient alternatives to several keyboard actions.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄️</td>
<td>Redo your last undo to playlist.</td>
</tr>
<tr>
<td>🎵</td>
<td>Highlight the track currently playing. Useful for long playlists.</td>
</tr>
<tr>
<td>🎮</td>
<td>Set the play mode: repeat tracks, random order, prefer rarely played, etc.</td>
</tr>
<tr>
<td>📌</td>
<td>Edit the playlist queue; which are tracks played first before the playlist resumes.</td>
</tr>
</tbody>
</table>

Current playlist saving options

By default, your saved playlist has a name composed of the date and time when you saved it (see image below). Right-click the playlist name to rename it. Right-clicking on a playlist name also allows you to add it to your existing playlist in the Playlist pane, or to replace your existing playlist.
2.5 The Context View

The power of Amarok is in the Context pane (in the center of the default Amarok window), where you can install various applets to help you enjoy and explore your music. Most of this additional information is obtained from the Internet, so a connection is important to get the most out of your Context pane. By default, three applets are preset: Current Track, Lyrics and Wikipedia.

2.5.1 Default layout

The default Context pane shows the following items: CurrentTrack, Analyzer, Wikipedia and Lyrics. Depending on the screen size the Lyrics might not be visible, but clicking on the button at the bottom will make it visible. When nothing is playing, the CurrentTrack applet will show the last played tracks and information about the Local Collection.
2.5.2 Customizing the Context pane

At the bottom of the Context pane are four buttons for the default applets. On the right of these buttons you see a remove button, clicking on it will show an error button allowing you to remove these applets. Click the applets to add them to the pane. Drag the labeled buttons to re-order the applets you have, and click the error button again to save your selections.

This makes the Context pane extremely flexible, maximizing the possibility of a custom display that fits your preferences. More here.

2.6 How to deal with problems

2.6.1 Some of the music is being rapidly skipped over

You may not have installed the necessary codecs. More about that here: FAQ: What Media Types Does Amarok Support.

Please refer to your distribution.
2.6.2 After my iPod has been mounted, it is not shown in the Content Browser

This should not happen. Check that the device has been properly mounted. Simply typing `mount` in a console will show you all mounted devices.

2.6.3 After I have updated my collection, the additions are not shown in the Content Browser

From the top-level menu Tools → Update Collection. If they don't show up, quit Amarok from the Amarok menu, or use `Ctrl-Q` to quit. Once you restart Amarok, your collection should show your updates.

2.6.4 Amarok cannot find the lyrics of the songs that I play

Possibilities:

1. The lyrics are not available in the sites checked on the Internet. You may wish to add more sites via the script menu.
2. The track numbering system within an album in your collection is not correct.
3. The title of your song contains special characters with a cedille, accent, etc. that do not show in your track title; therefore the lyrics script applet cannot find a match for your title. Check your tags and track numbering system with a tagger such as Picard.

2.6.5 My question isn’t answered here

More complex issues are covered in this handbook, including Troubleshooting and Common Problems, and the Amarok FAQ.

2.7 Glossary

2.7.1 Breadcrumbs

This is a way of navigating a hierarchical file structure; on Amarok near the top of the Media Sources pane. Starting at the Home folder level, it shows how deep one has navigated into the file system. When you have gone to a particular place in the file system, you will see all folders at a higher level. In Amarok the > links between folder levels allow you to find out what alternative folders are available at a particular level. The breadcrumbs are an efficient mechanism to navigate the whole file system on your computer.

2.7.2 Collection

All the sound files that Amarok has compiled in the database. Your collection may vary in size and composition of music tracks, depending which external devices (such as audio CDs or portable players with music) are connected and mounted on your computer.
2.7.3 Collection Browser

This is in the Media Sources pane for your ‘Local Music’ section and shows you the list of the music that you have in your collections. The Collection Browser allows you to search and sort your track lists by various id3 tags.

2.7.4 Playlist

A selection of tracks from your collection that you wish to play. Some portable music players have predefined playlists that are likely to differ from your Amarok playlists.

2.7.5 Script

Amarok plugin to extend functionality. Scripts are available from Settings → Configure Amarok → Scripts. Add more lyrics sources, more streaming stations, save covers to your album folders, burn CDs from playlists, etc.

2.7.6 Scrobble

To scrobble a track means that as you listen to it, the title of the track and artist are sent to a Web site such as Last.fm, where the information is added to your profile.

2.7.7 Stream, streaming

Like 20th-century radio stations, Internet radio stations send out ‘streams’ of content. One can find music, news, commentary and opinion. Many streams can be accessed through Amarok, either through scripts such as Cool Streams, or individually added by menu, Playlist → Add Stream.

2.7.8 Tags

The information about each of the tracks you listen to, e.g. album name, track title, composer, artist, year, etc. There is a standard called ID3 for including this information on audio CDs. You can edit the tags of individual tracks within Amarok if the file permissions are correct.
Chapter 3

The Amarok Window

When you open Amarok, this is what you will see, once Amarok has fully loaded:

![Default startup window](image)

3.1 Window Layout

Amarok is organized in four main areas, the toolbar and three panes:

<table>
<thead>
<tr>
<th>The Main Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Slim Toolbar</td>
</tr>
</tbody>
</table>
The Amarok Handbook

The Media Sources pane

The Context pane
3.2 Toolbar

3.2.1 Introduction

The Toolbar is used to manage the currently playing song. You can switch between the main and slim Toolbar using the View menu in the Menubar. The Menubar can optionally be hidden; use Ctrl-M to hide or re-display.

The Toolbar can be undocked and moved anywhere on your screen, and even used without the rest of the Amarok window displayed. To undock the Toolbar you should first make sure that the View → Lock Layout menu item is unselected. Now you can grab the toolbar at its left edge and drag it anywhere. To get it back just drag it into its old position while the layout is still unlocked.
3.2.2 Main Toolbar

This is the default Toolbar. It has a ▶ / ✕ button on the left and displays the song title, album and artist in the center-top.

The previous and next track are shown on either side of the song title. Clicking one of them will make Amarok skip to that track.

A Progressbar with the already played time on the left and remaining time on the right shows the current position in the song. If you have Moodbars enabled, and .mood files for your tracks, this is where they will be displayed. More about the Moodbar later.

By using the slightly transparent ❤ and ✨ buttons next to the text you can add the current song to your loved tracks on last.fm or add a position marker.

On the right is the volume-control button. A blue circle around the button shows the current volume. The volume is 0 at the bottom and increases clockwise. Change volume by clicking on the volume circle or by using the scroll wheel while the mouse hovers the button. The sound can also be completely muted by clicking on the speaker in the center.

3.2.3 Slim Toolbar

The Slim Toolbar has the same functionality as the Main Toolbar, but is more compact. Additionally the Slim Toolbar has a ✕ button to stop playing so the current song will be restarted when you press ✕ again. All buttons concerning the current track are on the left and only the volume control on the right side. Here the volume is controlled by clicking on the button and dragging the slider or using the scroll wheel while the mouse is hovering the button.

3.3 The Media Sources pane

The Media Sources pane on the left by default is where you access your local collection as well as other services: Local Music on top, which is the primary interface to your local collection and connected media such as mp3 players and CDs.

There is a section for all Internet Services that you have enabled. Here, you can browse listings of radio stations and podcasts; listen and/or subscribe to them, interact with your last.fm account, purchase music from online stores such as our new Amazon mp3 store, Magnatune and download independent artists’ music from Jamendo and more.

The Playlists section allows you to create and manage Dynamic Playlists, access your Saved Playlists as well as the Automatic Playlist Generator.

The Files section displays an integrated file browser and the Podcasts section offers you access to your podcast subscriptions.
3.3.1 Navigation Menu

The Navigation menu consists of the Filter bar, Bookmark button and Breadcrumbs navigation bar.

3.3.1.1 The Filter Bar

The Filter Bar filters the content according to the text in the box.

3.3.1.2 Bookmarks

To access this feature, click on the 🏷️ icon above the Filter bar.
### Menu Item

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark Media Sources View</td>
<td>Adds the current Media Sources view configuration to the bookmark list.</td>
</tr>
<tr>
<td>Copy Current View Bookmark to Clipboard</td>
<td>Copies bookmark to the system clipboard.</td>
</tr>
<tr>
<td>Bookmark Manager</td>
<td>Displays a list of all available bookmarks in a new window, with options to edit them.</td>
</tr>
<tr>
<td>Bookmark List</td>
<td>Lists all your bookmarks for faster selection.</td>
</tr>
</tbody>
</table>

### 3.3.2 Local Music

Displays the music from your default collection folder, sorted as specified. Both the regular (non-merged) view and Merged view of the same collection are shown, with the same sorting. Click the icon ![icon](image) to toggle between views.

#### Regular non-merged view

#### Merged view

Click the icon ![icon](image) to change the sorting criteria, using the following menu:
### Menu Item

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Artist/Album</td>
<td>Shows the collection sorted by artists and album names. If two entries have the same artist they will be sorted by album.</td>
</tr>
<tr>
<td>Album/Artist</td>
<td>Shows the collection sorted by album and artist names.</td>
</tr>
<tr>
<td>Genre/Artist</td>
<td>Shows the collection sorted by genre and artist. If two entries have the same genre they will be sorted by artist.</td>
</tr>
<tr>
<td>Genre/Artist/Album</td>
<td>Shows the collection sorted by genre, artist and album. If two entries have the same artist they will be sorted by album.</td>
</tr>
<tr>
<td>Levels</td>
<td>Designate the window cascade order of your elements.</td>
</tr>
<tr>
<td>Show Years</td>
<td>Check if you want years to be displayed.</td>
</tr>
<tr>
<td>Show Track Numbers</td>
<td>Check if you want track numbers to be displayed.</td>
</tr>
<tr>
<td>Show Cover Art</td>
<td>Check if you want cover art to be displayed.</td>
</tr>
</tbody>
</table>

### 3.3.3 Internet

Shows your internet collection, added and configured in Settings → Configure Amarok... → Plugins. More about configuring Internet Services. There are some scripts which add Internet Services; see Scripts for more information.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cool Streams</td>
<td>Lists quality radio streams.</td>
</tr>
</tbody>
</table>
3.3.4 Playlist

Media Sources Playlists menu:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Playlists</td>
<td>Dynamically updating parameter-based playlist; more on this <a href="#">here</a>.</td>
</tr>
<tr>
<td>Saved Playlists</td>
<td>Saved and imported playlists; more on this <a href="#">here</a>.</td>
</tr>
<tr>
<td>Automated Playlist Generator</td>
<td>Creates playlists by specific criteria; more on this <a href="#">here</a>.</td>
</tr>
</tbody>
</table>

3.3.5 Files

The Amarok file browser helps you add music to your collection, or simply play tracks from your hard drive.

Navigate through your files using the icon buttons: ‹ (previous), ‣ (next), ‣ (up),
The Amarok Handbook

(home), or (places), very similar to a web browser menu; or click on anywhere in the breadcrumbs to go directly to that level.

If you would rather search or filter for something rather than navigating to it, use the filter field to find the desired content. Partially type the name of the file and it will be displayed as in this example.

3.3.6 Podcasts

Lists your subscribed podcasts; from here you can listen, organize, add, import or unsubscribe podcasts.
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Podcast</td>
<td>Add a podcast URL: RSS 1.0/2.0 or Atom feed.</td>
</tr>
<tr>
<td></td>
<td>Add a folder to the podcast navigation menu.</td>
</tr>
<tr>
<td>Visible Sources</td>
<td>Selects what category of podcasts you can view.</td>
</tr>
<tr>
<td>Merged View</td>
<td>Displays the podcasts in a merged or unmerged view.</td>
</tr>
<tr>
<td></td>
<td>Checks all podcasts for updates and downloads any available.</td>
</tr>
<tr>
<td></td>
<td>Imports an OPML file from your hard drive.</td>
</tr>
</tbody>
</table>

3.4 The Context pane

The *Context* pane is a panel to which you can add various applets which offer information and media on the current music. A connection to the Internet is required for the most useful use of these little applications, which will fetch lyrics, information, photos, and even guitar or bass tabs, depending on which applets you choose to display.

3.4.1 Using the Context pane

*Context pane when not playing*

Pictured is the *Context* pane when no track is playing. If it is hidden, use View → Context to display it. The pane is divided in two parts:
The applet panel itself, where you can interact with some of the applets, such as editing lyrics or changing settings.

The lower portion of the panel, where you can expand and collapse applets and manipulate them in various ways once you click the Configure Applets icon.

### 3.4.1.1 Configuring Applets

Once you click in the lower portion of the Context pane changes slightly; each applet tab gets an icon that you can click to remove it, and a list of applets appear. To add new applet, simply click on the applet, and it will appear in the pane, ready to be used. To change the applet display order, click the tabs and drag them around the bar.

### 3.4.2 Applets

There are several applets available to dock in your Context pane; below is a description of each.

<table>
<thead>
<tr>
<th>Applet</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Track</td>
<td><img src="current_track_icon.png" alt="Icon" /></td>
<td>Information about the current track. You may rate it by clicking on the stars, add a position marker, or edit track metadata. When not playing, the applet displays collection information and Recently Played Tracks, which allows you to view the tracks and add them to the playlist.</td>
</tr>
<tr>
<td>Similar Artists</td>
<td><img src="similar_artists_icon.png" alt="Icon" /></td>
<td>Fetches artists similar to the currently playing one, with a short description and options to find them in your collection, or on Last.fm, and add to your current playlist.</td>
</tr>
<tr>
<td>Upcoming Events</td>
<td><img src="upcoming_events_icon.png" alt="Icon" /></td>
<td>Displays upcoming events that involve the current artist or group. You can set a venue locale to be watched by entering the applet settings and narrowing it down under the Favorites section.</td>
</tr>
<tr>
<td><strong>Wikipedia</strong></td>
<td><em>Wikipedia</em> page for the track or artist. Also browse other <em>Wikipedia</em> links, and use the back button to go back to the starting page.</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Labels</strong></td>
<td>View, add and edit Labels for the current song. To add a Label just type it in the text box and press <em>Enter</em>. Suggested Labels are user-contributed tags from <em>Last.fm</em>.</td>
<td></td>
</tr>
<tr>
<td><strong>Tabs</strong></td>
<td>Fetches and displays guitar and bass tabs (if available). Not editable.</td>
<td></td>
</tr>
<tr>
<td><strong>Lyrics</strong></td>
<td>Displays the lyrics of the song that is currently playing. Add or change lyrics scripts in the <em>Script Manager</em>.</td>
<td></td>
</tr>
<tr>
<td><strong>Albums</strong></td>
<td>View albums from the current artist or band that are available in your local Collection.</td>
<td></td>
</tr>
<tr>
<td><strong>Photos</strong></td>
<td>This applet queries <em>Flickr.com</em> for pictures of the band you’re listening to. Open the settings to add more keywords to your query (e.g.: live in tokyo).</td>
<td></td>
</tr>
<tr>
<td><strong>Analyzer</strong></td>
<td>This is a new applet in version 2.8. It provides basic audio visualizations. A right click on it allows to configure the applet settings.</td>
<td></td>
</tr>
<tr>
<td><strong>Info</strong></td>
<td>Information about the current media source. Allows you to navigate through internet services such as <em>Librivox.org</em>.</td>
<td></td>
</tr>
</tbody>
</table>

### 3.5 The Playlist pane

Amarok offers excellent playlist management for all of your songs and other audio files. Here you see a short playlist, sorted by album.
3.5.1 Basic Playlist Manipulation

Adding music to your playlist is a simple drag-and-drop, right-click or double-click operation. Two playlist-related options will be shown in the Context pane in the center (the Pop-Up Dropper, or PUD) when performing a drag-and-drop operation to add music to your current playlist.
The Amarok Handbook

You can either use **Add to Playlist**, which will append the songs you have selected, or **Replace Playlist**, which will replace all the contents of the playlist with your selection.

Alternatively, dragging-and-dropping your selection into a position in the *Playlist* pane also works.

Right-clicking on a track, album, or selected group will bring up a context menu from which you can **Add to Playlist**, or **Replace Playlist**.

Double-clicking a selection or pressing **Enter** while a track is selected in the *Media Sources* pane will perform the same as **Add to Playlist**.

Middle-clicking an item will append it to the playlist and begin playing from the start of the playlist.

If you tell the file browser to open a supported multimedia file, Amarok will append the selected file to the current playlist. Some multimedia files contain playlists themselves or may have playlist files associated by name (e.g. *wav* with *cue*). If Amarok detects such an association, it may add several items to the playlist.

### 3.5.2 Context menu

Right-clicking on any song or album in the playlist will bring up the *Playlist* context menu.

![Playlist context menu](image)

#### 3.5.2.1 Queue/Dequeue Track

Queuing a track will temporarily modify the play order without modifying the actual playlist order by setting the user-selected track as the next track.

As many tracks as required can be queued, and the order of queuing is indicated by a green circle with the determined order. Choose the tracks by **Shift-Click** for a block of tracks, or **Ctrl-Click** for individual tracks. The order in which the tracks are selected is the determined order.

Tracks can be dequeued by opening the context menu and selecting the **Dequeue Track** option.

More about the Queue Manager.

#### 3.5.2.2 Stop Playing After This Track

Choosing this option allows a track to finish, after which Amarok will stop playing. It will be indicated by the stop icon in place of the track number. Selecting this option on a track already marked will unmark it. Only one track in the playlist may be so marked.
3.5.2.3  Remove From Playlist

This removes the selected track from the current playlist.

3.5.2.4  Add Position Marker

Adding a position marker is only available for the currently playing track. This will add a bookmark in the seek bar at the top of the Amarok interface.

3.5.2.5  Show in Media Sources

This displays the track selected in the Media Sources pane, which is on the left by default.

3.5.2.6  Album

These are per-album options which will affect the entire album the track belongs to, rather than the track itself. The options are largely the same as the album menu in the Media Sources pane.

3.5.2.7  Edit Track Details

This option brings up the Edit Track Details dialog for the selected tracks.
3.5.3 Searching the Playlist

Amarok offers powerful searching capabilities for playlists. Simply enter your query for a song into the text box labelled **Search playlist** and it will match your keywords up against the match criteria you specify in the options menu — for instance, you can choose to search only by **Albums** and not **Artists**, or choose to match both of them.

**Playlist search bar**

Pressing the ↑ icon moves the selection to the previous search result, and ↓ moves to the next result, all without losing focus on the search input box.

The ToLeft icon in the search field will clear your query.

Enabling **Show only matches** from the menu will cause your playlist to display only the tracks matching the query.

More about **Playlist filtering here**.

3.5.4 Sorting Levels and Bookmarking

**Playlist sorting and bookmarking toolbar**
3.5.4.1 Sorting Levels

Menu for adding a sorting level

Amarok’s robust sorting abilities offer the ability to sort not only by one field of a track, but by many combined in a series of levels.

There are many different modes by which a sorting level can act. For instance, songs can be sorted by their Genre and then their Album.

A sorting level can be added by clicking the right-pointing triangle, which will bring up the menu for adding another sorting level.

Clicking the small triangle on the right of the sorting level’s name will cause items in the playlist to switch between ascending and descending order, which is indicated by the direction in which the triangle is pointing — up or down, respectively.

To remove a sorting level, click the name of the sorting level that precedes the one you wish to remove. Multiple sorting levels can be removed — provided that they are all lower in the hierarchy — by clicking on the ancestor of all of them. If you wish to clear all sorting levels, you can click the playlist icon to the left of the first right-pointing arrow.

3.5.4.2 Bookmarking

Bookmarking menu

The bookmarking menu provides options to save your current playlist layout. Clicking Bookmark Playlist Setup will add your playlist layout to the layout bookmarks, which can be viewed in Bookmark Manager.
The Amarok Handbook

**Copy Current View Bookmark to Clipboard** copies an Amarok playlist layout URL to the clipboard, which can be used for backing up your playlist layout.

### 3.5.5 Playlist Functions

The bottom bar of the *Playlist* pane provides various additional options for manipulation of your playlist.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Empty Playlist" /></td>
<td>Empty playlist of all playlists, albums and tracks.</td>
</tr>
<tr>
<td><img src="image" alt="Save Playlist" /></td>
<td>Save your playlist. Right-click to rename it, default is the date as a name. Left-click to bring up the <em>Save Playlist</em> menu, to save your playlist file onto the hard drive instead of the database.</td>
</tr>
<tr>
<td><img src="image" alt="Undo Playlist" /></td>
<td>Undo your last edit to playlist.</td>
</tr>
<tr>
<td><img src="image" alt="Redo Playlist" /></td>
<td>Redo your last undo to playlist.</td>
</tr>
<tr>
<td><img src="image" alt="Scroll Playlist" /></td>
<td>Scrolls playlist to the track which is currently playing and highlights it — useful for a large playlist.</td>
</tr>
<tr>
<td><img src="image" alt="Play Mode" /></td>
<td>Set the play mode: repeat tracks, random order, prefer rarely played, etc.</td>
</tr>
<tr>
<td><img src="image" alt="Queue" /></td>
<td>Edit the playlist queue; tracks played first before the playlist resumes. More about the <em>Queue Manager</em>.</td>
</tr>
</tbody>
</table>
3.5.5.1 Save Playlist menu

Left-click to bring up the Save Playlist menu, to save your playlist file onto the hard drive instead of the database.

3.5.5.2 Track Progression

The Track Progression menu enables you to modify the order in which Amarok progresses through the tracks in your playlist.

The top half of the menu specifies repeat options — whether songs should be repeated by track, by album or by playlist; whereas the bottom half specifies the order in which the tracks play in — in random order or by favor. Only one type of progression may be selected, e.g. you cannot select both random track and repeat playlist.
3.5.5.2.1 Favor

Favor is an innovative method to determine the next track to be played when using the random selection mode. The next track to be played can be determined depending on their score (a measure of how often they are played), their user-given rating, or if they have not been recently played.

*Playlist favor menu*

Favor is an innovative method to determine the next track to be played when using the random selection mode. The next track to be played can be determined depending on their score (a measure of how often they are played), their user-given rating, or if they have not been recently played.
Chapter 4

Configuring Amarok

On first start, some basic configuration is done; see also Quick Start Guide: Getting Started. But there is more under the hood.

To access the Configuration Menu, go to Settings → Configure Amarok... and see the following dialog:

![General configuration options](image)

4.1 General

In the screenshot above, see some General Options you can set. Depending on the distribution, the default settings can vary. When hovering over the options with the mouse pointer, a tooltip will show to explain the individual settings.

General options:
The Amarok Handbook

<table>
<thead>
<tr>
<th>Option</th>
<th>Tooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show tray icon</td>
<td>Check to enable the Amarok system tray icon.</td>
</tr>
<tr>
<td>Automatically retrieve cover art</td>
<td>Check to enable the automatic retrieval of cover art from the internet.</td>
</tr>
<tr>
<td>Enable context applets collapse animations</td>
<td>Check to enable animations when context applets collapse.</td>
</tr>
<tr>
<td>Automatically scroll playlist to current track</td>
<td>Check to make the playlist scroll so the current track is always visible.</td>
</tr>
<tr>
<td>Show Moodbar in progress slider</td>
<td>The Moodbar makes it possible to navigate in your music visually. Please note that this feature requires the external Moodbar Generator tool, or a script.</td>
</tr>
<tr>
<td>Moodbar style</td>
<td>Choose the mood display style.</td>
</tr>
</tbody>
</table>

When you enable the Moodbar, be aware of the following requirements: the Moodbar will only display if your tracks have been tagged with moods. For more about the Moodbar, refer to: Moodbar.

### 4.2 Local Collection

![Local Collection configuration](image)

*Local Collection configuration*

This dialog shows your file system in a tree structure, called Collection Folders. Selecting a folder always includes its subfolders. These folders will be scanned for media to make up your collection. You can right-click on a folder to individually rescans it, if it was previously selected.

Collection options:
The Amarok Handbook

<table>
<thead>
<tr>
<th>Option</th>
<th>Tooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fully Rescan Entire Collection</td>
<td>Rescan your entire collection. This will <em>not</em> delete any statistics.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports ratings and/or statistics from older Amarok versions, the batch scanner, or media players.</td>
</tr>
<tr>
<td>Scan folders recursively (requires full rescan if newly checked)</td>
<td>If selected, Amarok will read all subfolders.</td>
</tr>
<tr>
<td>Watch folders for changes</td>
<td>If selected, the collection folders will be watched for changes. The watcher will not notice changes behind symbolic links.</td>
</tr>
<tr>
<td>Importing Music: Transcode tracks</td>
<td>Whether Amarok should transcode tracks when they are copied or moved to <em>Local Collection</em>.</td>
</tr>
</tbody>
</table>

### 4.2.1 Import Statistics

This option allows you to import statistics, e.g. ratings and scores from either

- an older Amarok 1.4.x version (from SQLite, MySQL or PostgreSQL databases)
- from iTunes

It does *not* import statistics from an Amarok 2.x database, so if you want to merge an older 2.x database version, you will need to do this by hand.

### 4.3 Metadata
This dialog will allow you to configure the settings for metadata handling. This is a separate page starting with Amarok 2.7

Metadata options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Tooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write statistics to file</td>
<td>Check to write play-changing statistics as tags back to the audio files.</td>
</tr>
<tr>
<td>Write covers to file, maximum size...</td>
<td>Check to write changed covers back to the audio files. This will replace existing embedded covers. Select a value from the drop-down list to set the maximum size of the cover.</td>
</tr>
<tr>
<td>Enable character set detection in ID3 tags</td>
<td>If checked, Amarok will use Mozilla’s Character Set Detector to attempt to automatically guess the character sets used in ID3 tags. If your tags are correct, it is more safe to leave this option turned off.</td>
</tr>
</tbody>
</table>

4.3.1 Statistics Synchronization

This dialog will allow you to keep statistics of your collections synchronized. Make sure to only check collections between which you want to synchronize metadata.

Statistics Synchronization options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Tooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize Rating</td>
<td>Check to synchronize ratings between collections.</td>
</tr>
<tr>
<td>Synchronize First Played</td>
<td>Check to synchronize first played dates between collections.</td>
</tr>
<tr>
<td>Synchronize Last Played</td>
<td>Check to synchronize last played dates between collections.</td>
</tr>
<tr>
<td>Synchronize Playcount</td>
<td>Check to synchronize playcounts between collections.</td>
</tr>
<tr>
<td>Synchronize Labels</td>
<td>Check to synchronize labels between collections.</td>
</tr>
</tbody>
</table>
4.4 Playback

Configure the playback options, as well as the KDE multimedia framework Phonon.

<table>
<thead>
<tr>
<th>Option</th>
<th>Tooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fadeout on stop</td>
<td>If checked, Amarok will slowly fade the volume of the playing track on stop or at the end of the playlist, or stop playback immediately.</td>
</tr>
<tr>
<td>Fadeout on pause</td>
<td>If checked, Amarok will slowly fade the volume of the playing track on pausing the current track.</td>
</tr>
<tr>
<td>Fadeout duration</td>
<td>The length of the fadeout, in milliseconds.</td>
</tr>
<tr>
<td>Inhibit automatic suspend if playing</td>
<td>If checked, Amarok will prevent the computer from being suspended will a track is playing.</td>
</tr>
<tr>
<td>Pause playback on suspend</td>
<td>If checked, Amarok will pause playing of the current track when the computer is about to suspend.</td>
</tr>
<tr>
<td>Resume playback on start</td>
<td>If checked, Amarok will resume playback where you left it the last session -- just like a tape-player.</td>
</tr>
</tbody>
</table>
4.4.1 Configuring Phonon

Phonon is the multimedia framework used by Amarok. It was created to allow KDE 4 to be independent of any single multimedia framework such as GStreamer or VLC and to provide a stable API for KDE 4’s lifetime. As an added bonus, it simplifies development by providing a simple API that works across different platforms such as Windows and OS X.

The result of all this for you, the user, is that you can choose the multimedia framework that works best for you. This is usually pre-configured by your distribution.

Playback problems in Amarok are typically not Amarok issues, but rather Phonon issues, as Amarok doesn’t handle sound directly anymore.

4.4.1.1 Device Preference tab

![Sound System - Amarok](image)

Depending on your OS and distribution, you may need to use ALSA, OSS, PulseAudio, or something else as your default playback device. Find one that works for you with the Test button and apply to all types of output. If you would like different types of output to go with different devices, this is possible as well.
4.4.1.2 Speaker Setup tab

Should you wish to change the standard speaker setup, here is the place to do it.

4.4.1.3 Backend tab

Depending on your operating system you may see options such as Gstreamer, VLC, or DS9 (Windows) here. The recommended phonon-backend for Linux® users is VLC or Gstreamer.
If you don’t see VLC or Gstreamer, install the package for it. For most distributions the package for VLC, for example, would be `phonon-backend-vlc`.

Each backend comes with its own codecs, so depending on the backend you choose you will need to also download the codecs, as most distributions don’t ship them for legal reasons.

### 4.5 Notifications

![Notifications configuration dialog](image)

<table>
<thead>
<tr>
<th>Option</th>
<th>Tooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use On-Screen Display</strong></td>
<td>Check to enable the On-Screen Display. The OSD briefly displays track data when a new track is played. Once checked, the OSD will be visible on your screen and you can drag it to the location you prefer.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>The time in milliseconds for which to show the OSD. The value must be between 500 ms and 10000 ms.</td>
</tr>
<tr>
<td><strong>Screen</strong></td>
<td>Allows you to choose the screen that should display the OSD if you have a multiscreen setup. Default is 0.</td>
</tr>
<tr>
<td><strong>Translucent</strong></td>
<td>Check to enable translucency if supported by your desktop system.</td>
</tr>
<tr>
<td><strong>Font scale</strong></td>
<td>(choose the size of the font in the OSD)</td>
</tr>
<tr>
<td><strong>Don’t show when a fullscreen application is active</strong></td>
<td>Do not show On-Screen Display if another application is focused and running in fullscreen mode.</td>
</tr>
<tr>
<td><strong>Use custom colors</strong></td>
<td>Check to enable custom colors for the On-Screen Display text.</td>
</tr>
</tbody>
</table>
4.6 Database

The default database is already set to use embedded MySQL. For most users there is no need to configure an external database, as there is no change in performance. If you want to share your database or use it remotely, you can configure an external MySQL database.

Amarok expects the external database and user account to already exist. The user also requires full access to the database. You MUST restart Amarok after changing these settings.

If your database is not already set up, you can use the SQL commands in the field at the bottom to do so, after replacing the password with the correct one.

<table>
<thead>
<tr>
<th>Option</th>
<th>Tooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use external MySQL Database</td>
<td>Check to enable the use of an external database.</td>
</tr>
<tr>
<td>Server</td>
<td>Enter the name of the existing MySQL server.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number to access the server. Default is port 3306.</td>
</tr>
<tr>
<td>Username</td>
<td>Enter the username to access the database with full access privileges.</td>
</tr>
</tbody>
</table>
The Amarok Handbook

<table>
<thead>
<tr>
<th>Password</th>
<th>Enter the password for the default user.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Enter the name of the database. Default preset is amarokdb.</td>
</tr>
</tbody>
</table>

You can find more information about the External Database [here](#).

## 4.7 Plugins

![Plugins configuration dialog](#)

Plugins configuration controls [Collections](#), [Internet Services](#), and [Local Collection Backends](#).

### 4.7.1 Collections

Amarok offers you access to the following Collections, if they are available:

<table>
<thead>
<tr>
<th>Collection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AudioCD Collection</td>
<td>AudioCD collection plugin for Amarok</td>
</tr>
<tr>
<td>DAAP Collection</td>
<td>DAAP collection plugin for Amarok</td>
</tr>
<tr>
<td>iPod, iPad &amp; iPhone Collection</td>
<td>Plugin to use iPod-like devices as collections in Amarok</td>
</tr>
<tr>
<td>MTP Collection</td>
<td>MTP collection plugin for Amarok</td>
</tr>
<tr>
<td>Universal Mass Storage Collection</td>
<td>UMS/USB collection plugin for Amarok</td>
</tr>
<tr>
<td>UPnP Collection</td>
<td>UPnP collection plugin for Amarok</td>
</tr>
</tbody>
</table>


4.7.2 Internet Services

Amarok offers by default the following Internet services:

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
<th>Needs configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ampache</td>
<td>Use an external music server</td>
<td>Yes, <strong>Ampache</strong> server needed</td>
</tr>
<tr>
<td>gpodder.net</td>
<td>Podcast service. See also gpodder.net</td>
<td>No</td>
</tr>
<tr>
<td>Jamendo</td>
<td>Listen to free music published under Creative Common licenses. See also Jamendo.com</td>
<td>No</td>
</tr>
<tr>
<td>Last.fm</td>
<td>A popular internet radio service, streaming only for subscribers. See also Last.fm</td>
<td>Yes, personal information to scrobble</td>
</tr>
<tr>
<td>Magnatune Store</td>
<td>Preview and buy music from a non evil record label. See also Magnatunes.com</td>
<td>Only for downloads</td>
</tr>
<tr>
<td>MP3 Music Store</td>
<td>Access the Amazon MP3 Store directly from Amarok</td>
<td>Yes</td>
</tr>
<tr>
<td>mp3tunes</td>
<td>A personal mp3 locker. See also mp3tunes.com</td>
<td>Yes</td>
</tr>
<tr>
<td>Podcast Directory</td>
<td>Browse and subscribe to a huge choice of podcasts</td>
<td>No</td>
</tr>
</tbody>
</table>

Other service are available through scripts.

4.7.3 Local Collection Backends

Amarok offers you access to the following Local Collection Backends, if they are available:

<table>
<thead>
<tr>
<th>Devices</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Files &amp; USB Mass Storage Backend</td>
<td>Local Collection folders on local and pluggable disks</td>
</tr>
<tr>
<td>NFS Share Backend</td>
<td>Local Collection folders on remote NFS shares (Network File System)</td>
</tr>
<tr>
<td>SMB (Windows) Share Backend</td>
<td>Local Collection folders on remote Samba (Windows) shares</td>
</tr>
</tbody>
</table>

4.7.4 Ampache configuration

If you have access to a remote **Ampache** music server, click and enter the necessary information. You can configure access to more than one **Ampache** server. For more information see the **Ampache** section in what follows.
4.7.5 Last.fm configuration

While streaming is free with Last.fm’s own online player for residents of the US, the UK and Germany, it only works in Amarok for paid subscribers. Scrobbling is free, however, provided you enter your Last.fm username and password by clicking 📜. Amarok allows you to store the password in the secure KDE Wallet. If you decline the use of Kwallet, your password will be stored in clear text instead.

4.7.6 Magnatune Store configuration

Listen to the music offered by Magnatune for free and buy it directly through Amarok. Click 📜 to add your membership credentials if you are a member and/or add your email address to re-download music you previously have downloaded from Magnatune.

To download, you then go to the Media Sources pane, select the Internet section and click on the Magnatune Store. It will then download the catalog where you can search and select the music you want to buy.

4.7.7 MP3 Store configuration

Access the Amazon MP3 Store directly from Amarok.

The Amazon MP3 Store needs to know what country you are located in because it offers different items depending on your location. The following countries are allowed:

- France
- Austria, Germany, Switzerland
- Japan
- United Kingdom
- United States (default)

NOTE: Changing the country invalidates your shopping cart. If your country is not in the list, you cannot use the Amazon MP3 Store because it is not supported by Amazon.

4.7.8 mp3tunes configuration

If you have a personal mp3tunes locker, click 📜 and enter your username and password. You will then be able to access your online locker.
4.8 Scripts

Scripts configuration dialog

Script Configuration in Amarok covers Generic, Lyrics, and Scriptable Service scripts. Scripts are added in the Manage Scripts dialog.

4.8.1 Generic scripts

Generic scripts add functionality to Amarok. The Amarok Script Console is available by default; other scripts which add CD burning, cover image storage, games, and many other choices are available. If installed, these scripts will show up in the Tools menu.

4.8.2 Lyrics scripts

A variety of lyrics scripts are available; Ultimate Lyrics is provided by default. Your chosen lyrics scripts will provide the lyrics shown in the Lyrics applet in the Context pane.

4.8.3 Scriptable Services scripts

Scriptable services, if enabled, will show up in the Internet Services in the Collections pane. Many collections of streams are available, in many languages, and from many sources.

4.8.4 Manage Scripts

At bottom of the configuration dialog are two options:

- Automatically update built-in scripts
The Amarok Handbook

Automatically download and install updates for the built-in scripts from the Amarok website if available. Enable if you usually have a working Internet connections, and want your scripts automatically updated. This will not update user-supplied scripts from KDE-apps.org.

- **Manage Scripts** button

Browse, install and uninstall user-supplied scripts; also search, sort and rate the scripts in the *Amarok Add-on Installer*.

### 4.8.4.1 Add-on Installer

Using the *Add-on Installer*, one can install the latest user-contributed Amarok scripts. There are also options to search, sort and rate the scripts.

The **Install Scripts** and **Uninstall** buttons can be used to manage scripts. One can install script packages of type amarokscript.tar, amarokscript.tar.bz2, amarokscript.tar.gz

### 4.8.4.2 Script Information

Learn more about a script using the **button**.

A script can also be executed directly in the Amarok Script Console. This is activated by selecting the Script Console and confirm the selection by hitting either the **OK** or the **Apply** button. To deactivate the Script Console deselect it and confirm again.
4.9 Changing Layouts

4.9.1 Changing the Amarok Window Layout

The visibility of each of the three Amarok panes is indicated in the View menu (part of the top-level menu). If you unlock the layout, each of the three panes will show two clickable boxes. These two boxes allow you to rearrange or customize the layout of your Amarok window. Clicking the X closes that particular pane. Having been closed, a pane can be activated again by checking the appropriate box in the View menu. Clicking Reset Layout will of course reset the layout back to the default look.

4.9.1.1 Undocking Amarok panes
Clicking the hollow symbol on the left of the cross causes that panel to be undocked, so it will appear as a separate window on your desktop. Repeating this action on the undocked pane will dock it again inside your Amarok window. You can drag the panes inside your Amarok window to reorder them. You may stack the panes, or even put one or two of them covering the others, selectable by tabs.

4.9.1.2 Lock and save Amarok window layout

If you are satisfied with the layout inside your Amarok window, you can lock this layout by clicking the appropriate item in the View menu. Be aware that if you want to be sure your layout is preserved when you shut down your session with Amarok still open, quit Amarok first by either choosing Amarok → Quit, or by typing Ctrl-Q.

4.9.2 Changing the Toolbar

You can also choose between two layouts of the Toolbar by clicking the appropriate item in the View menu:

<table>
<thead>
<tr>
<th>Main Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slim Toolbar</td>
</tr>
</tbody>
</table>

More about the Toolbar here.
4.9.3 Changing the Playlist layout

To access the Playlist Layout Editor, go to Playlist → Playlist Layouts → Configure Playlist Layouts... and you will see the above editor window. On the left you can see the preset layouts; clicking on those allows you to see how the configuration is done on the right. Clicking on the Preview button allows you to see the applied layout in the Playlist pane.

4.9.3.1 Modifying a default layout

To modify one of the default layouts, first make a new copy of it: simply click on and save it under a new name. To generate a new layout, click on A layout consists of 3 elements: the Album Head, the Album Body (with a special album body for Various Artist tracks) and the Single Tracks configuration, selectable in the tabs in the middle of the editor. To add an item, simply drag it from the selector on top and drop it in the layout tab elected below. To show the album cover, just check the Cover field.

In addition, you can also add:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show inline playback controls</td>
<td>playback controls will appear below the line of the playing track.</td>
</tr>
<tr>
<td>Show tooltips</td>
<td>Tooltips showing ID3 tag information will be shown on hovering over a track.</td>
</tr>
</tbody>
</table>

4.9.3.1.1 Item layout configuration

Each of the added items can then have its own layout configured: hovering over the item shows a wrench, clicking on this wrench will let you access a configuration dialog for that item. The
example below shows you the configuration dialog for the *Album* item:

You can then decide of the total width of the item (100% is the total width of the line, so if you use a custom width and have more than one item on a line, you need to reduce that width per item), its alignment, the font weight and whether the tag should be shown with a prefix or suffix.

### 4.9.3.1.2  Example: single line layout

*Example:* to generate a single line layout without grouping you only add items in the *Single Track* element.

### 4.9.3.1.3  Playlist layout storage

The playlist layouts will be stored in xml format in `$HOME/.kde/share/apps/amarok/playlist_layouts` (might be `$HOME/.kde4/share/apps/amarok/playlist-layouts` for some distributions).
Chapter 5

Organization

Organizing your music makes it easier to find what you want. Amarok offers you several tools to assist.

First, organize your collection of music, both local and remote:

- **Collection**
  - Collection Scanning
  - Search in Collection
  - Organize Collection
  - Remote Collections
    * Ampache
    * DAAP
    * Samba
    * UPnP
  - External Database
  - Working with Media Devices

The **Cover Manager** organizes your album covers, the **Tag Editor** helps Amarok categorize your tracks, and transcoding allows you to transfer tracks to your devices in encoding they can play.

- **Cover Manager**
- **Tag Editor**
- **Transcoding**

### 5.1 Collection

Amarok organizes your music in the **Collection**.

- **Collection Scanning**
- **Search in Collection**
- **Organize Collection**
- **Statistics Synchronization Between Collections and with Last.fm**
5.1.1 Collection Scanning

Every time Amarok is displaying a collection the information about tracks and albums needs to come from a source.
The source can be a portable device, an Internet service or a database.
For tracks that are in Local Collection folders Amarok is using a database to have fast access to the required meta-information.
At first this information needs to be loaded into the database which is usually done by scanning the Local Collection directories for audio files.
This process is called collection scanning.
It is useful to understand the scanning process in order to work better with Amarok.

5.1.1.1 Incremental Scan / Update Collection

The so-called incremental scan will check the collection directories for updates.
This is done every minute if Watch folders for changes is enabled (on by default) but can also be triggered manually by selecting Update Collection from the menu.
The incremental scan will just check the modification date of every folder in the collection against the last known modification time.
This has a couple of implications:

• You can trigger a rescan of one directory by modifying its time (such as using touch /path/to/directory in the console).

• If files inside a directory are changed the scanner will not notice, because changing a file updates its modification time but not the time of the parent folder. On the other hand most programs that modify the files save them atomically by using a temporary file which is then renamed. Such procedure does update directory modification time and thus triggers directory rescan.

• If the collection folders are on a very slow partition the process of checking all the modification times can take some time. Usually this information is cached by the operating system but with large collections that might not be possible. In such a case the scanner might appear to scan continuously. With collections above thousands of directories or when collections are stored on a network drive or an NTFS partition it is recommended to switch off the Watch folders for change option.

If you have problems with deleted tracks still appearing in the collection, or you want to update album covers (which are not updated by a mere Update collection) then you can use the Full rescan option in the settings dialog.

Full rescan will not care about modification dates. It will not delete statistics of existing files; it will, however, delete statistics of tracks that disappeared from the currently mounted collection folders. Because of that it is advisable to perform the Full rescan only with all Local Collection folders mounted if you move the tracks between mounts. Full rescan also updates play count if the one stored in file tags is greater, rating if the song is unrated and file tags mention rating and score (under the same circumstances).
5.1.1.2 Progress bar / scanning time

The progress bar will show the progress of the scanning.
Up to 50% the scanner will scan the file system and just buffer the result.
Times above 50% indicate that the scanner is committing the results to the database.
Usually the second step is much faster than the first so don't be surprised if the progress bar seems to jump.
Up to 50% aborting the scan is possible. After 50%, the committing of the files cannot be stopped.
The scanning time depends on your disk speed and other factors.
Usually the first scan is a lot slower than subsequent scans where the files are cached by the operating system.
A scan of 10000 files should take around three minutes on a modern computer. 50000 files should be around 13 minutes. Of course with an SSD (solid state drive) this will be much faster.

5.1.1.3 Backup of collection

With the default settings Amarok is storing all the collection information in a directory called ~/.kde/share/apps/amarok/mysql/. It can be a good idea to make a backup of this directory from time to time, especially when you didn’t enable the writing back of statistics information.

5.1.1.4 About unique ids

Amarok is tracking files by an id that is either stored in the audio track or computed using file metadata, tag metadata and first few kilobytes of the file.
This id helps Amarok to identify tracks that are moved to other locations so that statistics information (rating, score, playcount, first & last played) are not lost.
Currently Amarok will not import tracks with duplicate unique ids.
This leads to the surprising behavior that copied tracks still appear only once in Amarok.
In some circumstances even different tracks can end up with the same unique id. Such a problem can be seen by the debug output (start Amarok with the --debug option in a console) while scanning.

5.1.1.5 About Albums

The scanner can only read single tracks but Amarok will display those sorted by album and compilation (an album without one specific artist). Amarok can’t rely on the directory in which the files are located, since directory organizational schemes vary so widely.
The scanner is therefore doing the following:

• Tracks without an album artist or an artist (or a composer in case of a classical track) are placed in a compilation.
• Tracks that have the compilation flag set or an album artist other than ‘various artists’ will be placed in an album.
• Tracks that have the compilation flag set to 0 are placed in a compilation.
The Amarok Handbook

- If we end up having tracks with several different artists left over they are placed inside a compilation, or else we make one album out of them.

This process is quite complicated. However usually the outputs of the scanner can help in figuring out why the tracks are sorted as they are.

In such a case try executing (on a command line) `amarokcollectionscanner -r /tildelow/your/music/directory`

Look for ‘compilation’ tags and tracks with different ‘artist’ and ‘albumartist’ tags.

You can remove the compilation tag from mp3 files with the following command: `id3v2 -r TC your filename here`

5.1.2 Search in Collection

`Search Collection` lets you specify complex filters to search for specific tracks in your collection.

Use the edit box in the `Media Sources` pane or click the button right next to the edit box. Alternatively you can simply press `Ctrl-F` to activate the search bar.

5.1.2.1 Edit Box

When you type in the input field, Amarok will search for the text in all available tags such as artist, album and title. Your view of the collection will update automatically to display only the matches of the search.

Pressing `Enter` after searching will populate your playlist with all of the found search items and clear the search box. This is a great way to quickly add hundreds or thousands of tracks to a playlist instantly!

To search in a specific tag, type `tag:value` into the search bar. Operators like ‘>’ and ‘<’ can be used to create more general conditions. Several conditions can be used together by separating them by a space character. For time conditions, use the following abbreviations: `d=day, w=week, m=month, y=year`. 

76
5.1.2.2 Tags

The following tags can be searched:

- Album
- Artist
- Bitrate
- Composer
- AlbumArtist
- Genre
- Playcount
- Rating
- Sample Rate
- Score
- Title
- Track
- Year
- BPM

5.1.2.3 Additional searchable fields

Along with tags, the following can also be searched:

- Comment
- Filename
- Disc number
- Length
- Filesize
- Format
- Added (to Collection)
- First played
- Label
- Last modified

5.1.2.4 Operators

Numerical tags can use the following operators to create a condition:

- Equal: ‘:’
- Less than: ‘<’
- Larger than: ‘>’
5.1.2.5 Examples

If you search without specifying a tag, Amarok will search in all important text tags:

More complex patterns can be used to get better results:

5.1.3 Edit Filter Dialog

If you prefer to build your searches more programmatically, drag down the icons for the search terms you want, and drag to change search-term order. You may search by: Simple text, Title,
5.1.4 Organize Collection

While organizing your collection in Amarok is a straight-forward task, you will be manipulating the actual files on your hard drive. Please be sure you have a backup of your files before you begin.

With the Organize Files dialog of Amarok you can easily manage the media files on your hard drive. When you change the naming scheme of media files, you will organize them, which is very powerful. To access the Organize Files dialog, right-click Local Collection → Organize Files in the Media Sources pane and the menu interface will pop-up.

**WARNING**
Using this option will move the files to a new location, so you not only need appropriate rights for both the origin and the destination location, but also enough space, usually the double of the total file size to have the action perform smoothly. If you are unsure, do NOT use this option.
If the option **Organize Files** does not appear, you may have Merged View on (toggled by ). In order to safely organize your files, you need to see your collections separated, not merged.

### 5.1.4.1 Organizing Files Interface

After selecting the option **Organize Files** you will first see an additional option that allows you to move the files to a new location, as well as transcode them at the same time. Depending on the codecs you have installed on the system, some format options might not be available and will be grayed out:
First screen when choosing the Organize Files option

For more information about Transcoding, please see the Transcoding section.

After clicking on the Move button on top of the screen, the following interface will show:

Organize Tracks dialog

5.1.4.2 Contents
<table>
<thead>
<tr>
<th>Interface Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection Folder</td>
<td>The default collection folder. Set multiple folders in <strong>Settings → Configure Amarok</strong>.</td>
</tr>
<tr>
<td>Token Bar</td>
<td>Drag and drop multiple tokens here to change the naming scheme of your media files. Only available in <strong>Basic</strong> view.</td>
</tr>
<tr>
<td>Format Presets</td>
<td>When you have created your naming scheme, save it as a preset by clicking <strong>Save Preset</strong>. Remove presets by clicking <strong>Remove Preset</strong>.</td>
</tr>
<tr>
<td>Replace Spaces With Underscores</td>
<td>If checked, converts spaces in filenames to underscores.</td>
</tr>
<tr>
<td>Ignore ‘The’ in Artist names</td>
<td>If checked, artists’ names starting with ‘The’ will instead be styled ‘, The’.</td>
</tr>
<tr>
<td>VFAT Safe Names</td>
<td>If checked, all non-ASCII characters will be replaced with underscores. <em>Do not check this option if you have non-English characters in your tags.</em> Most people can leave this option unchecked.</td>
</tr>
<tr>
<td>Restrict to ASCII</td>
<td>If checked, all non-ASCII characters will be replaced with underscores. <em>Do not check this option if you have non-English characters in your tags.</em> Most people can leave this option unchecked.</td>
</tr>
<tr>
<td>Custom Character Replacement</td>
<td>Replace the tag expressions you write under the <strong>Replace</strong> box with character strings you write in the <strong>With</strong> box. Useful if there are mis-spellings in CDBB.</td>
</tr>
<tr>
<td>Destination Preview</td>
<td>Shows the original naming scheme of your media files and how they will look after the changes are applied (not available since ver. 2.4.2).</td>
</tr>
<tr>
<td>Overwrite Destination</td>
<td>If checked, overwrites files of the same name without asking for further confirmation (not available since ver. 2.4.2).</td>
</tr>
</tbody>
</table>

### 5.1.4.3 Advanced Contents

The code version of the **Token Bar**, which allows you to code the name format of media files. Activate it by pressing **Advanced...** in the interface menu. To change back click **Basic...**. Enclose conditional inclusion arguments such as CD number in braces, like this:

```
%artist%/%album%{/Disc %discnumber%}/%track% %title%
```

Note: formerly, the coding was `%token`, as of 2.4 it is `$token$`.  

You can use the following tokens:

- Album Artist, The or The Album Artist - %albumartist%
- Artist, The or The Artist - %artist%
- File Extension of Source - %filename%
- Artist’s initial - %initial%
- The Album Artist - %albumartist%
- The Artist - %artist%
- Track Number - %track%

If you surround sections of text that contain a token with curly-braces, that section will be hidden if the token is empty.

```
%artist%/%album%/%track% _%title%
```
5.1.5 Statistics Synchronization Between Collections and with Last.fm

Beginning with version 2.7, Amarok allows syncing the play-related metadata and statistics of the tracks (such as rating or play count) between any of your collections which show up in Media Sources → Local Music and with the Last.fm web service, if you choose to use Last.fm.

5.1.5.1 Manual Syncing

At any time, you can start manual synchronization from Tools → Synchronize Statistics...

From here, you can start a synchronization between the collections you select here, which will default to what you have configured in the Amarok Metadata configuration.

5.1.5.1.1 Conflicts and Syncing Statistics Dialog

When syncing, Amarok will show a dialog window which states the conflicts and statistics of the syncing that has recently been in progress. In this window you will be able to see three tabs: Matched Tracks, Unique Tracks and Excluded Tracks.
The Amarok Handbook

Matched Tracks
This tab will show all the tracks that Amarok has found in more than one collection, and reflects conflicts. When tracks are grouped, you can see two types of background: light green, and light red. A light green background indicates the new or updated field, whilst a light red background will indicate the old/overwritten field. You do not need to solve all conflicts listed here; the particular field of the listed tracks are not going to be synced if you do not resolve the conflict.

Unique Tracks
These are tracks found in only one collection. You can use it as a difference view. Track dragging is supported here.

Excluded Tracks
These are tracks that are not synced because of different reasons, such as identical metadata, so as not cause to disorder in the database.

5.1.5.2 Synchronizing with Last.fm
If you have the Last.fm plugin enabled and configured correctly with your Last.fm account, you can choose to also synchronize your Amarok play counts, ratings and labels with your Last.fm Library. The sync takes some time, but you may continue using Amarok while it is syncing. Please note that Unattended Synchronization (which will be explained later on) is not possible with Last.fm, and synchronization from Last.fm to Amarok needs to be initiated manually.

5.1.5.2.1 Spelling Auto-Correction
Last.fm enables by default a feature that will auto-correct common misspelling during the sync. It can happen that even if you scrobble many track plays, it does not show up in Matched Tracks as Last.fm knows the track under a slightly different name.
You can disable this feature on the Last.fm site, and changes will be applied also to your past scrobbles. You have two options:

**Off**
Tracks are matched properly, but if you change your tags after some time, your play-count will be split in two tracks.

**On**
You can play-count the tracks even if tags are changed after some time, but you will have to use Last.fm preferred spelling.

### 5.1.5.3 Unattended Syncing

**IMPORTANT**
Please note the dialog will only appear in the case of iPods.

When you connect a device that is able to sync with your collections, a pop-up like this will appear.
For unattended syncing to start, you only need to click Yes in the pop-up. Amarok will work in the background, so the metadata in your device including ratings, first/last played times, play counts and labels will be synced with other collections configured to participate in the synchronization, and tracks recently played on the device will be scrobbled to Last.fm, if it is enabled. The process will not ask for user interaction unless any conflict is found in the middle.

5.1.6 Remote Collections

Often it is very useful to share your media files across the network, especially if you want to use it on different computers. This can be done in different ways:

- Ampache
- DAAP
- Samba
- UPnP

5.1.6.1 Ampache

Amarok is able to play music from an Ampache media server. If you want to install a server, see here for more information.
5.1.6.2 Ampache Client

Activate the Ampache service using **Settings → Configure Amarok → Plugins**. Click on the icon to open the configuration dialog.

Select **Add Server**:

Configure the service with the data entered on the server:
Now the **Ampache** service should appear in **Media Sources → Internet**.

**5.1.6.3 Digital Audio Access Protocol (DAAP)**

DAAP is a protocol to share media over a network. It was first used for the **iTunes** music player, but is used widely now. The current state is that the DAAP-plugin won’t work with a recent iTunes, the Firefly media server is known to work.

**5.1.6.4 Client**

Amarok will show the tracks from the server in the **Media Sources → Local Music** pane if you enable the DAAP Collection in **Settings → Configure Amarok → Configure Plugins → Collections**. If the collection is not showing up, click the ![icon](image) to be sure you are not in Merged View.
5.1.6.5 Samba

Samba is a free implementation of the SMB/CIFS protocol which is used to share files and printers in a network. Most modern file managers like Dolphin and Nautilus support this protocol.

5.1.6.6 Client

You need to mount the share to use it in Amarok. To do this, you need to install the package `smbfs`. Use the command

```
sudo mount -t cifs / / host / share /mount-point/
```

to mount the share. After that you can use it like a local folder and add it to your local collection.

5.1.6.7 Server

The easiest way is to use your file manager. On Debian-based distributions like Ubuntu™ you can install a Dolphin extension to manage shares using

```
sudo apt-get install kdenetwork-filesharing
```

Open the properties of a folder in Dolphin and switch to the Share tab.
To share the folder, just check the **Share with Samba (Microsoft Windows)** field and set the share name under the **Name** field. Check the **Allow Guests** checkbox to allow anonymous users access to the folder.

The folder should now be accessible to the network. Please see the Client section for details on how to use it in Amarok.

**5.1.6.8 Universal Plug and Play (UPnP) / DLNA**

*UPnP* is a set of protocols to share media on the network. It is also supported by a wide range of residential gateways and Network Attached Storage devices. *UPnP* support is now commonly
marketed as **DLNA**.
Amarok has a built-in UPnP media share client so it can play tracks shared on the network. To enable it, use **Settings → Configure Amarok → Plugins → Collections** and check the box by the **UPnP Collection** plugin.

When a media share is discovered it will be shown in **Local Music**.

The UPnP feature depends on **KDE's UPnP media server support**. As of now (2015) there is no working UPnP kio-slave available.

### 5.1.7 External Database

Amarok 2.2 and above support an external **MySQL** database as a backend.
5.1.7.1 Install MySQL-Server

First you need to install an MySQL server. On Debian-based distributions like Ubuntu you can use

```
sudo apt-get install mysql-server mysql-client
```

to install it. You will be asked to specify a password for the root-account for the database. The `mysql-client` package is needed in order to execute some of the commands in this document, but it's not fundamental to the use of Amarok.

5.1.7.2 Configure Database

Connect to the local database using

```
mysql -u root -p
```

You will be prompted for the password for MySQL's `root` user. You will get the

```
mysql>
```

prompt.

Create a new user `amarokuser` with the password `amarokpass` using the

```
CREATE USER 'amarokuser'@'localhost' IDENTIFIED BY 'amarokpass';
```

command. Amarok needs its own database, which is created with

```
CREATE DATABASE amarokdb;
```

Give the new user access to the database by entering the

```
GRANT ALL ON amarokdb.* TO 'amarokuser'@'%' IDENTIFIED BY 'amarokpass';
```

command, where `%` is a wildcard to allow all hosts to connect to the database. Now use the

```
FLUSH PRIVILEGES;
```

statement to reload various internal caches used by MySQL. Finally

```
exit
```

closes the MySQL prompt.

By default the server can only be accessed by the local host. To change this you need to edit the file `/etc/mysql/my.cnf` and adjust the address near `bind-address` to the one your server listens on the network. `0.0.0.0` listens on all interfaces. After that you need to restart the server using

```
sudo service mysql restart
```

5.1.7.3 Configure Client

Open the configuration dialog by clicking Settings → Configure Amarok → Database. Enable the checkbox and enter the user data.
You need to restart Amarok so that the changes take effect.

5.1.7.4 Migrating from MySQL Embedded to MySQL Server

If you want to maintain the statistics, etc. that you have in the embedded MySQL database from before Amarok 2.2, you can do the following:

First, start Amarok 2.2+ at least once to give the database a chance to update to the latest schema version.

Next, kill the running MySQL service

```
sudo /etc/init.d/mysql stop
```

and start a MySQL daemon from your `~/.kde4/share/apps/amarok` directory (`--defaults-file MUST be the first option!

```
/usr/sbin/mysqld --defaults-file=`pwd`/my.cnf --default-storage-engine =MyISAM --datadir=`pwd`/mysqle --socket=`pwd`/sock --skip-grant-tables
```

The skip-grant-tables means you can use any password or username to connect to it. 'localhost' will not work, the MySQL client will try to use a UNIX® socket. Using `127.0.0.1` as the host makes it work. Some systems may restrict this access through apparmor or SELinux®. They can be temporarily disabled with

```
sudo /etc/init.d/apparmor stop
```

Now, run mysqldump, passing in the `-S` option to specify the local socket. This will dump your old embedded DB out to a SQL file.

```
mysqldump -S sock amarok > amarok.mysql
```

You can then restart your MySQL service and load this SQL file into your MySQL server. You’ll have needed to already run the GRANT statement above and create an Amarok database (`CREATE DATABASE amarok;`):

```
sudo /etc/init.d/mysql stop mysql -u amarokuser -p amarok < amarok.mysql
```

NOTE
You may need to re-scan your collection in Amarok after completing this.
5.1.8 Working with Media Devices

Use Amarok to play music from media devices such as MTP devices, iPods, and generic USB devices.

5.1.8.1 Connecting Media Devices

Connect your media device using the USB cable. The device notifier applet in KDE will automatically pop up with a list of all available media devices. Click on the icon to access your device.

5.1.8.2 Play Music from the Media Device

Or just wait until your device shows up in Amarok, which will take anywhere from a few seconds to a minute or more, to scan the device for music tracks. Until then the vfat volume will show 0 tracks.
After the scan, Amarok will display all the music tracks available in the Media Device, which you can then move to the Playlist to play them, or copy or move to your Local Collection.
5.1.8.3 Managing the Media

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to playlist</td>
<td>Adds all the selected tracks from the media device to the current Amarok playlist.</td>
</tr>
<tr>
<td>Replace playlist</td>
<td>Clears the current Amarok playlist and adds instead all the selected tracks from the media device.</td>
</tr>
<tr>
<td>Configure Device</td>
<td>Opens a dialog box to edit configuration options for the device.</td>
</tr>
<tr>
<td>Disconnect Device</td>
<td>Disconnects the device from the computer.</td>
</tr>
<tr>
<td>Copy to collection</td>
<td>Copy all the selected tracks to the Local collection or to any other media devices connected.</td>
</tr>
<tr>
<td>Move to collection</td>
<td>Move all the selected tracks to the Local collection or to any other media devices connected.</td>
</tr>
<tr>
<td>Move to trash</td>
<td>Moves all the selected tracks from the media device to the trash.</td>
</tr>
<tr>
<td>Delete tracks</td>
<td>Deletes all the selected tracks from the media device.</td>
</tr>
<tr>
<td>Organize Files</td>
<td>Organizes tracks based on the configuration for the device.</td>
</tr>
<tr>
<td>Edit track details</td>
<td>Opens a dialog box to edit details of the selected tracks from the media device.</td>
</tr>
</tbody>
</table>

5.1.8.4 Troubleshooting Media Device support

As of Amarok 2.8, the following devices should work with Amarok:

- Generic Media Players connected through the UMS protocol.
• iPods/iPhones, depending on their support by the libgpod library. The status depends on the version of this library installed on your system, please refer to the libgpod support listing on their homepage.

• limited support for devices using the MTP protocol, the support for new Android devices is currently implemented for the next Amarok version.

5.2 Cover Manager

The Cover Manager is a tool to manage the cover art images of your collection. It allows you to change covers easily, fetch all missing covers and browse them. You can find Cover Manager in Tools → Cover Manager.

When scanning the local music library, Amarok tries to find corresponding covers for albums. At this point, Amarok only searches them from the file system, not from the Internet. If none are found in your files, Amarok uses a placeholder image like this for the album cover:

If an album is missing a cover or the current one is incorrect, you can fetch one from the Internet with Cover Manager.

5.2.1 Browsing Covers

With Cover Manager, browsing covers is easy. You can view covers for any artist by selecting from list on left, or use the search box to find the right album. On the status bar, you can see how many covers are currently listed and how many albums are missing covers. You can also set the Cover Manager to only show albums with or without covers. By right-clicking on cover art and selecting Display Cover you can view the cover image at the original size.
5.2.2 Fetching Missing Covers

If there are albums with missing covers, you can try to automatically fetch them all from the Internet. Just select **Fetch Missing Covers** from the top of the window and **Cover Manager** will try to find covers. If there are many albums missing covers, the process may take some time.

5.2.3 Changing Cover Art

If there is an album with an incorrect cover, you can fetch a new one from the Internet. Right-click on the cover and select **Fetch Cover**. A dialog window for finding a new cover will open. **Amarok** automatically tries to find the correct album art by searching with the artist name and album name. Usually this works very well, as with the example, and you will most likely see a correct cover on results as in the example. If no correct cover is found, you can try to enter a custom search phrase or change the source of images by clicking on **Configure...** You can select where to search, including Last.fm, Google Images, Yahoo! Image Search or Discogs. After finding a cover for an album, just click **OK** and the changes will be applied.

You can also use an image from your hard drive as an album cover. If you want to store the image in the Album folder, name it **cover.jpg** or **cover.png** for best results. As before, right-click on the incorrect image and click on **Set Custom Cover**.

If you don’t like the cover art at all, you can unset it by right-clicking on the image and selecting **Unset Cover**.

**Tip**

You can find this menu without **Cover Manager** too. Just right-click on the album or song from your playlist or collection and hover the **Album** item.

5.3 Tag Editor

The built-in **Tag Editor** allows to show and change meta data of music files. To open the editor just right-click on one or more selected songs, albums, or genres, in either your collection or your
playlist, click on Edit Track Details and choose the Tags tab.

5.3.1 Edit Tags Manually

Change the proper line to the required value and click Save & Close. Clicking Cancel discards all unsaved changes.

5.3.1.1 Tags

Tags are metadata such as the track number or the artist of the track contained in the file. A very common kind of tag is the ID3 tag.

Here is a list of tags supported by Amarok:

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the track.</td>
</tr>
<tr>
<td>Artist</td>
<td>The artist or band of the track.</td>
</tr>
<tr>
<td>Composer</td>
<td>The composer of the track.</td>
</tr>
<tr>
<td>Album Artist</td>
<td>The artist or band of the album.</td>
</tr>
<tr>
<td>Album</td>
<td>The album title.</td>
</tr>
<tr>
<td>Disc Number</td>
<td>The disc number of the album; important in a multi-CD album.</td>
</tr>
<tr>
<td>Genre</td>
<td>The genre of the track. This can be a custom genre, but usually one of the predefined ones is used.</td>
</tr>
<tr>
<td>Beats Per Minute</td>
<td>The tempo of the track.</td>
</tr>
<tr>
<td>Track</td>
<td>The number of the track on the album.</td>
</tr>
<tr>
<td>Year</td>
<td>The year in which the track or album was published.</td>
</tr>
<tr>
<td>Comment</td>
<td>A text comment for the track.</td>
</tr>
</tbody>
</table>

5.3.1.2 Edit Single Track

In this mode you can change all supported tags of the chosen file.
5.3.1.3 Edit Several Tracks

Several tracks can be selected by clicking on the artist, album, or genre in the your collection or by selecting several tracks in the playlist using the Ctrl (non-sequential) or Shift (sequential) key.

5.3.1.4 All At Once

More general tags can be set for a group of tags at once. It works just like the single-track-mode, but the title and track number tags are locked.
5.3.1.5 Track By Track

This mode is pretty similar to the single-track-mode, except for the ability to switch between the selected tracks using the Next and Previous buttons. It is activated by clicking on the checkbox Per Track on the bottom of the window.

5.3.2 Get Tags from MusicBrainz

Amarok 2.8 has the ability to guess tags from the MusicBrainz database. Click the Get Tags from MusicBrainz, wait a moment for the database to be searched for matches, and then Update Tags, or Cancel.

If you have the packages libofa and ffmpeg installed, and Amarok is compiled with them, Musicbrainz will be able to use ‘fingerprinting’ (the MusicDNS service) to search for albums and tracks without good filenames or existing tags.
5.3.3 Guess Tags From Filename

It is also possible to tag tracks using information in the filename. This is a very convenient feature when dealing with lots of files with a consistent naming scheme.

Some tracks need to be edited manually, because special characters like single quotes are omitted in file names. A preview helps to create the correct pattern.

5.3.3.1 Options

There are also several options to format the result. These are self-explanatory.
The Amarok Handbook

5.3.3.2 Basic

In the basic view you get a drag-and-drop menu to create the pattern in the filename.

5.3.3.3 Example

Filename: 01-The Beatles-Hey Jude.mp3
Tracknumber: 01
Artist: The Beatles
Title: Hey Jude
5.3.3.4 Advanced

In the advanced view you can create a pattern using markers in a string.

Filename: 01-The Beatles-Hey Jude.mp3
Tracknumber: 01
Artist: The Beatles
Title: Hey Jude

5.3.3.5 Example
5.4 Transcoding

Transcoding allows you to encode media files to a variety of formats while copying or moving them to a collection (Local Collection, USB Universal Mass Storage Collection and iPod, iPad & iPhone Collection support transcoding as of Amarok 2.8). A word of warning: be careful when you use this feature, as you are working with actual files on your hard drive. Have a backup!

5.4.1 Interface

The Transcoding dialog will appear whenever you copy or move tracks to one of the collections that support transcoding. You can also transcode tracks within the Local Collection by using the Organize files functionality.

5.4.2 Transcode Tracks Dialog

If you choose to copy or move files to a supported collection, the following dialog will pop up:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Selected media files will be copied to your collection without re-encoding.</td>
</tr>
<tr>
<td>Encoder list</td>
<td>List of all your installed codecs; choose among them to be able to transcode. If this list is empty, you need to install FFmpeg.</td>
</tr>
<tr>
<td>Transcode all tracks</td>
<td>Transcode every selected track to the chosen codec</td>
</tr>
<tr>
<td>Transcode only when needed for playability</td>
<td>Only transcode tracks which need to be transcoded to play in the destination system</td>
</tr>
<tr>
<td>Transcode only if source and destination formats are different</td>
<td>Transcode only if source and destination file formats are different</td>
</tr>
</tbody>
</table>
5.4.3 Custom Encoding

Whether to save space, to make your files readable by a portable music player or a particular software program, Amarok can handle it. Choose a codec from the list and a custom setting and click Transcode.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transcode</td>
<td>Begins encoding with the selected codecs and parameters. In case of the Local Collection the Organize tracks dialog will pop up. More about Organize tracks.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Exits the Transcode Tracks dialog.</td>
</tr>
</tbody>
</table>

5.4.4 Saving Transcoding Preferences

As mentioned in the Remember this choice for the next time description, Amarok can remember transcoding preference per each of your collections. The preference can be changed any time in the Configure Local Collection Configure Amarok dialog page for the Local Collection and in the configure dialogs of iPod, iPad & iPhone and Universal Mass Storage collections.
5.4.5 Pro Tip: Strip Audio out of Video Files

Amarok’s transcoding capabilities can be used to extract audio from video files while copying or moving them into a collection. Just select video file(s) in Amarok embedded file browser, right-click and choose Copy to Collection. Standard Transcode Tracks dialog will appear. Choose one of the encoders, hit Transcode and transcoding will begin.

5.5 Script Manager

The Script Manager contains the options required to extend the functionality of Amarok through custom scripts. It is reached from the Settings menu, Configure Amarok → Scripts. Scripts can be installed from downloaded script packages, or from the Manage Scripts button which can fetch and install the latest user-contributed scripts from the Internet.

Please refer to Configuring Amarok -> Scripts for more information.
Chapter 6

Playlist

The Playlist is a powerful part of Amarok. One can drag in some tracks, but there is a lot more available.

- Saved Playlists
- Playlist Filtering
- Queue Manager
- Dynamic Playlists
- Automatic Playlist Generator

6.1 Saved Playlists

Saved playlist is a traditional type of playlist. Saved playlists work like Amarok’s current playlist, saved in the Amarok database or your file system for later use. It can be fun to use them at events when you have specific songs you want played.

Creating a saved playlist is very easy with the exact songs and order that you want. For every day use, sometimes it is faster to use Dynamic Playlists or the Automatic Playlist Generator when you have less specific needs for specific tracks and progression.

To browse and manage your saved playlists, go to Playlists → Saved Playlists on the menubar.
6.1.1 Managing saved playlists

6.1.1.1 Saving a Playlist

You can save your current playlist into the Amarok database by clicking the save icon ( ) at the bottom of the Playlist view. You can browse playlists in the Amarok database by going to Playlists → Saved Playlists in the Media Sources pane and expanding the Amarok database section. You will find them in your filesystem here: ~/.kde/share/apps/amarok/playlists.

6.1.1.2 Exporting a Playlist

You can export your current playlist to your file system by clicking Playlist → Export Playlist As... from the top menubar. From the opening save dialog, you can change the name, location and type of the playlist. Then just click on Save. Remember, playlist files don’t contain any music data. If you want to listen the content of the playlist on another computer, you’ll need to bring your music with you unless that computer already has the tracks.

6.1.1.3 Importing a Playlist

You can import a playlist file into Amarok just by copying it to any directory that Amarok knows as part of your music collection. When Amarok detects a new playlist on any folder of your collection, it will add it to the Playlist Files on Disk section of Playlists → Saved Playlists in the Media Sources pane. If the playlist doesn’t appear right away, you can update the collection manually by clicking Tools → Update Collection. If instead of importing the playlist, you want to just listen it, open it with Amarok → Play Media... from menubar. Selected playlist will be added to the current playlist.
6.2 Playlist Filtering

The *Search playlist* function in Amarok is very powerful, as it allows you to search for different tracks by various constraints. The search results limits what you can actually see, which makes it easy to queue up wanted tracks, or remove them from the playlist.

### 6.2.1 Edit Box

When you type something in the *Search playlist* field, Amarok will search in your playlist and mark matching tracks, artists and so forth.

#### 6.2.1.1 Examples

The first track that matches the current search will be highlighted as in this example:

![Search example](image)

### 6.2.2 Search Preferences

This is a small drop down menu with options for the search field, if you need more than simple search. You can choose which types of searching you want to use in your *Search playlist*. Check the boxes according to what you need for your search.
6.2.2.1 Check boxes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracks</td>
<td>Amarok will search for text from tag: Track Titles</td>
</tr>
<tr>
<td>Albums</td>
<td>Search for text from tag: Album titles</td>
</tr>
<tr>
<td>Artists</td>
<td>Search for text from tag: Artist</td>
</tr>
<tr>
<td>Genre</td>
<td>Search for text from tag: Genre</td>
</tr>
<tr>
<td>Composers</td>
<td>Search for text from tag: Composer</td>
</tr>
<tr>
<td>Rating</td>
<td>Search the rating of all songs in your playlist</td>
</tr>
<tr>
<td>Years</td>
<td>Search for year of publication</td>
</tr>
<tr>
<td>Show only matches</td>
<td>When this box is marked Amarok will display only the tracks that match the current search</td>
</tr>
</tbody>
</table>

6.2.2.2 Show only matches - example
6.3 Queue Manager

Tracks are loaded in the Playlist. In normal track progression, when a song is over, the next one played is the one below the just-played one. The Queue is one way to change the order in which the songs are played.

6.3.1 How to Create a Queue

It is very easy to make a Queue; just select one or more tracks and move in the center of Amarok, to the Pop-Up Dropper (PUD), or right-click and scroll to Queue Track.

As you select or add songs to the Queue each of them takes a number. The number indicates the order in which songs will play.

6.3.1.1 Example

First, select the track

Then right-click for context menu
6.3.2 How to Edit the Queue

If you want to make any changes in the Queue you can use the Queue Editor. Start the Queue Editor from the menu in Playlist → Edit Queue.
6.3.2.1 Queue Editor

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Move selected track ahead in the list.</td>
</tr>
<tr>
<td></td>
<td>Move selected track below in the list.</td>
</tr>
<tr>
<td></td>
<td>Remove selected song from the Queue.</td>
</tr>
<tr>
<td></td>
<td>Remove all songs from the Queue.</td>
</tr>
</tbody>
</table>

6.4 Dynamic Playlists

Some media players are designed to load the entire collection of music in a single playlist, then play it in random order, or search/sorted, then queued. With a larger collection, this way of managing your playlist isn’t efficient. Amarok’s Dynamic Playlist is a better way to explore your music.

The Dynamic Playlist is reached from Playlists → Dynamic Playlists in the Media Sources pane.
6.4.1 How the Dynamic Playlist works

The dynamic playlist is a list that grows while you listen to your music. It will keep a certain number of songs in front of the currently played song and it will clean up the playlist by removing old songs. The songs that will be added to the front of the playlist are determined by the currently selected dynamic playlist.

6.4.2 Using a Dynamic Playlist

To enable dynamic playlists, click the button in the Dynamic Playlist pane. A bar will be displayed at the top of the Playlist pane announcing that it is enabled. Select which dynamic playlist to use from the list of options by double clicking it. The currently selected dynamic playlist is bolded.

You can adjust the number of songs before and after the currently playing song to be displayed in the playlist with the Previous and Upcoming fields. You can prevent the same track appearing in the current playlist more than once using the button. The Repopulate button allows you to generate a new set of tracks. This can be used together with a high Upcoming setting to generate fixed playlists for export.

6.4.3 Defining Dynamic Playlists

Each dynamic playlist is built of biases. A bias defines a particular constraint on the behaviour of the dynamic playlist, and new items to be added to the playlist are selected at random from a list of all songs which match the biases. Biases may either be a single bias (e.g. the Search bias) or a grouping of other biases (e.g. the Match All bias). Some examples playlists are included, and you can define a new playlist with the button.
To change the name of a playlist, either use the rename button or right click on it and select **Rename playlist**. A bias can be edited with the same button or by right-clicking and selecting **Edit bias**, and for biases which have sub-biases, a new sub-bias can be added by right clicking and selecting **Add new bias**.

### 6.4.3.1 Biases

Because multiple biases may be defined, Amarok may at times return an empty playlist. This occurs if it is given a set of impossible-to-fulfill conditions. To avoid this and to better understand each available bias, along with any options it takes, please see below:

**Search**
- This bias matches tracks found by a given search query. It uses the same search string used in the collection browser. You may also use the **Match meta tag** bias to match tags in the same way as the collection search editor.

**Random**
- This bias matches any track, entirely at random.

**And**
- This group bias matches tracks which match **all** sub-biases.

**Or**
- This group bias matches tracks which match **any** sub-biases.

**Partition**
- This group bias matches tracks from the sub-biases in proportion. The edit window for this bias has sliders for each sub-bias to adjust the proportions. For example, with two sub-biases with their proportion sliders set equal, half of the playlist will match one bias and half the other.
- Note: The dynamic playlist is internally working with more tracks than you can see, so after clicking 'Repopulate' the list might not contain a 50:50 distribution of songs. However as you continue listening to music you will see that in the end it actually matches.

**If Else**
- This group bias matches tracks from the first sub bias **unless** there are no matching tracks found, in which case it matches tracks from the second sub-bias. See the example **Album Play** playlist for an example of this in use.

**Match Meta Tag**
- This bias matches tracks which meet certain conditions on a tag. The selection interface is the same as the search filter editor in the collection browser. Select a tag type from the drop-down and fill in the constraint. (Hint: You can use a number of these in an **And** bias.)

**Album Play**
- This bias matches tracks related to the previous item in the playlist by album. You can select the details of the bias from the drop-down menu. For example, **Track directly follows previous track in album** is used in the example **Album Play** playlist to ensure full albums are played in order.

**Quiz Play**
- This bias matches tracks for which the first character of a given tag (title, artist or album) is the same as the last character of the same tag for the previous tag. For example, with artist selected, you could have the following series: Led Zeppelin -> Nine Inch Nails -> Santana, etc.
EchoNest similar artist
This bias matches tracks which are similar according to EchoNest, either to the previous track or to any track in the playlist. This allows you to play a set of consistent tracks simply by adding a single track to the playlist and turning on the dynamic playlist, rather than defining all the match rules yourself.

Last.fm similar
This bias performs the same function as the EchoNest bias, but uses Last.fm to determine similarity. You can also choose similarity to the previous track or to the previous artist.

Last.fm weekly top artist
This bias matches tracks which are on the weekly charts from Last.fm for a given time period.

6.4.4 A dynamic playlist in use

6.4.5 Using your Dynamic Playlist
To enable the dynamic playlist you have created simply check the On box in the upper-left corner of the pane. To regenerate the entire playlist at any time, click Repopulate, to the right of On.

The default number of items in the playlist is your 5 previous plays plus 10 upcoming items. With the currently playing track, this makes 16 items in the playlist at any given time. The number of tracks can be changed right below the On checkbox.

Below that is the dropdown menu for loading saved playlists, the button to save playlists, and the button to delete them.
6.4.6 A dynamic playlist in use

The Automated Playlist Generator (APG) automatically generates playlists based on constraints you set. These constraints can be set based on song data (artist, genre, year) or access time (last played). There are also special constraints to determine how Amarok is going to look for songs. You will find the APG in your Media Sources pane, Playlists → Automated Playlist Generator.

6.5 Automatic Playlist Generator

The Automated Playlist Generator (APG) automatically generates playlists based on constraints you set. These constraints can be set based on song data (artist, genre, year) or access time (last played). There are also special constraints to determine how Amarok is going to look for songs. You will find the APG in your Media Sources pane, Playlists → Automated Playlist Generator.

6.5.1 APG Presets Toolbar

This is the APG Presets toolbar. From left to right we have the following buttons:

- Adds a blank preset that can be modified.
- Opens up the APG Preset Editor window to edit the currently selected preset constraints.
- Removes the selected preset from the list; can not be undone.
- Import a preset from a .xml file. Has the potential to be malformed if edited outside Amarok; use the constraint tester.
- Export the selected preset to a .xml file that can be imported.
- Loads APG with the selected preset and automatically generates a playlist.
6.5.2 Working with Presets

Presets are sets of rules that Amarok APG will use when generating playlists. These rules are going to be referred to as constraints from now on; every preset is determined by the constraints which create it. Groups of constraints hierarchically and logically organized are called constraint trees.

6.5.2.1 Constraints

Constraints are the building blocks of constraint trees. They are simple statements that the APG will use to add songs to the playlist it generates. To add a constraint to the currently selected preset constraint tree click the button in the APG Preset toolbar and click the Add new option on the APG Preset Editor window. Note that this will add the constraint under the selected item (constraint or constraint group).

Many different kinds of constraints can be added; each works in a different way inside the tree.

6.5.2.2 Constraint Types

Amarok APG supports several types of constraints:

<table>
<thead>
<tr>
<th>Constraint</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Tags</td>
<td>The most important constraints, because they can be set to virtually any information regarding the file, including: artist name, album name, genre, year, last played, and score.</td>
</tr>
<tr>
<td>Playlist Duration</td>
<td>Set the running time (in HH:MM:SS format) that the playlist should have</td>
</tr>
</tbody>
</table>
The Amarok Handbook

<table>
<thead>
<tr>
<th><strong>Playlist Length</strong></th>
<th>Determine how many songs should be in the playlist</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Checkpoint</strong></td>
<td>Tell Amarok where to start and stop looking for tracks</td>
</tr>
<tr>
<td><strong>Prevent Duplicates</strong></td>
<td>Prevent Amarok from selecting the same tracks, songs from the same artist, or the same album</td>
</tr>
</tbody>
</table>

Note that you can change how constraints work in various manners, such as setting the fuzzy-exact slider, which determines how closely the constraint is going to be followed.

Another way to modify constraints that is present on Match Tags with a text-based tag is found in the line below the Field option box. In the text field to the right you write the text to be matched and in the option box at the left of the value you can select contains (which will consider any songs that have the according text in their tag), matches (which will consider songs whose corresponding tag match exactly the one in the text box), starts with and ends with.

Similarly, you can also edit the way value-based constraints (such as the Playlist Length constraints and the playcount Match Tag constraint) behave by changing the option close to the text to settings such as fewer than, equals and more than.

Another way to change constraint behavior is to check the invert checkbox on them, this makes them behave the opposite way, a ‘Match Tag: artist contains name’ becomes ‘Match Tag: artist not contains name’.

6.5.2.3 Constraint Groups

Constraint groups can be added from the Add new option from the APG Preset Editor window, constraints under a group are logically linked, the same applies to groups under groups.

There are currently two kinds of constraint groups: ‘Match all’ groups and ‘Match any’ groups. ‘Match all’ groups require that all the constraints under them are met by the song, ‘Match any’ groups require that at least one of the constraints under them are met by the song. To add a constraint under a specific group highlight it on the preset editor and use the Add new option.

6.5.3 Using your Presets

Once you set up a preset, you just have to select it on the APG Presets panel in the Automated Playlist Generator (APG) and click the toolbar to run APG with the selected preset. You will then have a playlist matching your criteria, like this:
The Amarok Handbook

Playlist generated by the constraint tree below.
Chapter 7

Various

Topics which didn’t fit elsewhere, such as a Moodbar, Amarok on other platforms, troubleshooting, common problems, and the FAQ:

• Moodbar
• ReplayGain
• Amarok on other Desktops and Operating Systems
  – Non-KDE Desktops
  – Amarok on Windows
  – Amarok on OS X
• Troubleshooting and Common Problems
• FAQ

7.1 The Moodbar

The Moodbar shows you the ‘mood’ of a track, which you can then use to figure out when something interesting happens in the song.

In order for Amarok to display moodbars for your music, you will need the Moodbar program (see below for downloads and binary packages).

The Moodbar package requires GStreamer and various plugins depending on the filetypes you use (see Supported filetypes). You will not need the phonon-backend-gstreamer package to create .mood files.

There are two parts to the new Moodbar implementation: the Moodbar package, which contains a program that takes a music file and generates a .mood file, and support code in the Amarok source, which runs the binary and displays the Moodbar. The Moodbar package depends on the GStreamer libraries. Without the Moodbar package, Amarok cannot generate the moodbars for your music.

As an alternative, there is a new script which will create moodbar files for tracks in an Amarok playlist; this is an exception to the above. The script needs nothing but Amarok to work, but it only creates the .mood files as they are played in the Playlist.

The Moodbar is due to the work of Gavin Wood and Simon O’Keefe, who designed the algorithms; their original paper is here.
7.1.1 Summary of Requirements

- The Moodbar binary, in your PATH (it should be listed upon running `which moodbar` from a console) — Remember to configure the Moodbar package with proper path, e.g. build and install with commands `./autogen.sh --prefix='pkg-config --variable=prefix gstreamer-1.0' && make && sudo make install`

- The GStreamer 1.0 library and plugins for the formats you want Moodbar to be able to analyse. (An earlier GStreamer 0.10 based version is also still available for some distributions)

- The Fastest Fourier Transform In The West (fftw.org) FFTW library version 3.0 or above (at least single-precision floating point version - libfftw3f) — If your platform does not provide this for you or you need to compile your own version, remember to configure the FFTW package with `./configure --enable-single`

- A version of Amarok with a Use moods option in the General section of the configuration screen. This means 1.4.4 or higher in the 1.4 series or 2.2.2 or higher in the 2.x series.

**NOTE**
Systems with package managers should automatically install the GStreamer plugins and FFTW along with the Moodbar package if available; this information is provided mostly for people who want or need to compile from source or manually install packages, or where the distribution specific instructions are outdated and no updated moodbar package is yet available.

7.1.2 Usage

Currently .mood files must be generated manually. Amarok cannot do it for you. To do this for your entire collection, use the Moodbar File Generation Script described below.

To enable the display of moodbars in Amarok, activate it in the configuration: Settings → Configure Amarok → General → Show Moodbar in Progress Slider. Moodbars should now appear in the track sliders in the player window and Playlist; there will also be a mood field that you may add to your playlist layouts.

7.1.3 Installation

7.1.3.1 Source Downloads

Latest release: moodbar-0.1.4.tar.gz — this is the Moodbar source package, which contains the Moodbar program (which generates .mood files from music files), and a GStreamer plugin that does the work. The Moodbar package needs GStreamer 1.0.* installed, plus the 1.0.* version of various plugins. Be sure to install the Moodbar package into the same prefix as GStreamer — follow the instructions in the summary of requirements chapter. The 0.1.4 is a fork of original 0.1.2 sources, updated to use GStreamer 1.0. The old 0.1.2 sources are not reliably available online any more, but packages might be still available for some distributions.

If you find any bugs, please submit a bug report at bugs.kde.org.

7.1.3.2 Debian packages

**NOTE**
This section contains old instructions for the GStreamer 0.10 based moodbar version 0.1.2, they might be outdated.
A package for Moodbar is now available in Debian unstable. Simply run `apt-get install moodbar`. You will likely also want to install gstreamer0.10-plugins-ugly, gstreamer0.10-plugins-good, and gstreamer0.10-plugins-bad for format support.

### 7.1.3.3 Kubuntu and Ubuntu packages

This section contains old instructions for the GStreamer 0.10 based moodbar version 0.1.2, they might be outdated.

A package for Moodbar is available in the official package repository; just ensure the universe section is activated (which should be default anyway). Just install the package moodbar with your preferred package manager (**Kpackagekit**, **Aptitude**, **Adept**, **Synaptic**). You will likely also want to install gstreamer0.10-plugins-ugly, gstreamer0.10-plugins-good, and gstreamer0.10-plugins-bad for format support.

Or, to install, paste this into **Firefox** or Konqueror and hit **Enter**.

```
apt://moodbar,gstreamer0.10-plugins-ugly,gstreamer0.10-plugins-good,gstreamer0.10-plugins-bad?section=universe?refresh=yep
```

### 7.1.3.4 Gentoo ebuilds

This section contains old instructions for the GStreamer 0.10 based moodbar version 0.1.2, they might be outdated.

Moodbar is available in Portage, simply **emerge moodbar**. Unofficial ebuilds are no longer required.

### 7.1.3.5 RPM builds

This section contains old instructions for the GStreamer 0.10 based moodbar version 0.1.2, they might be outdated.

If you are a rpm-based distro user, you can build a .rpm using rpmbuild with latest `gstreamer-plugins-moodbar.spec`. The binary package will be soon available for PLD-linux distro.

### 7.1.3.6 Fedora

This section contains old instructions for the GStreamer 0.10 based moodbar version 0.1.2, they might be outdated.

In Fedora 7 and higher (up to 16 as of this writing) Moodbar is available in the default repositories. Simply install it with your PackageKit GUI or with the following yum command:

```
yum install moodbar
```
7.1.3.7 openSUSE packages

GStreamer 1.0 based version 0.1.4 is available in KDE:Extra repository for openSUSE Leap 42.3 and later. An earlier GStreamer 0.10 based version 0.1.2 is also still available in the main repository for some openSUSE versions.

For details on how to add repositories, see the openSUSE wiki.

1-Click Install for openSUSE - just choose your version and installation procedure will do the rest:

• openSUSE Tumbleweed
• openSUSE Leap 15.0
• openSUSE Leap 42.3

7.1.3.8 Mandriva packages

This section contains old instructions for the GStreamer 0.10 based moodbar version 0.1.2, they might be outdated.

First of all, you need to add PLF repositories, so visit easyurpmi.zarb.org and add them to your repositories list.

Then simply install the following packages:

• gstreamer0.10-moodbar
• gstreamer0.10-plugins-ugly
• gstreamer0.10-plugins-good
• gstreamer0.10-plugins-bad

7.1.3.9 Arch Linux®

This section contains old instructions for the GStreamer 0.10 based moodbar version 0.1.2, they might be outdated.

There is a PKGBUILD for Moodbar in the Arch User Repository (AUR) available here.

For more information about the AUR and working with PKGBUILDs, see the AUR User Guidelines.

7.1.3.10 FreeBSD

This section contains old instructions for the GStreamer 0.10 based moodbar version 0.1.2, they might be outdated.

There is a port: audio/gstreamer-plugins-moodbar here.

To install the port: cd /usr/ports/audio/gstreamer-plugins-moodbar/ && make install clean
To add the package: pkg_add -r gstreamer-plugins-moodbar
7.1.4 Moodbar File Generation Script

Here is a simple bash script that will add .mood files to your entire collection. It adds mood files for all files matching the extensions in the current directory and all subdirectories, so it’s best run from the base of your music directory.

```bash
#!/bin/bash
DIR=${1: - .}
LAST=./.moodbar-lastreadsong
C_RET=0
control_c() # run if user hits control-c
{
    echo "" > "$LAST"
    echo "Exiting..."
    exit
}
if [ -e "$LAST" ]; then
    read filetodelete < "$LAST"
    rm "$filetodelete" "$LAST"
fi
exec 9< <(find "$DIR" -type f -regextype posix-awk -iregex '.*\.(mp3|ogg|flac|wma)' ) # you may need to add m4a and mp4
while read i
    do
        TEMP="${i%.*}.mood"
        OUTF='echo "$TEMP" | sed 's #\([^,]*\) #\1/\2#' '
        trap 'control_c "$OUTF"' INT
        if [ ! -e "$OUTF" ] ; then
            moodbar -o "$OUTF" "$i"
        fi
    done <&9
exec 9<&-
exit $C_RET
```

Copy and paste the above into a text file named moodbar.sh in your music directory and run the following commands:

cd /path/to/music bash moodbar.sh

Alternatively if the above does not work, you may try:

```bash
chmod +x moodbar.sh ./moodbar.sh
```

This may take a very long time for large collections! Note that the moodbars will not appear in Amarok until Amarok rescans the collection. The generated mood files will be dotfiles (i.e., prefixed with a full stop), or hidden files - so keep this in mind if you can’t find any generated mood files.

Based on the above script, an alternative for multicore CPUs:

```bash
#!/bin/bash
NUMCPU="$(grep 'processor' /proc/cpuinfo | wc -l)"
find . -type f -regextype posix-awk -iregex '.*\.(mp3|ogg|flac|wma)' | ←
while read i ; do
    while [ `jobs -p | wc -l` -ge $NUMCPU ] ; do
        sleep 0.1
    done
    TEMP="${i%.*}.mood"
    OUTF='echo "$TEMP" | sed 's #\([^,]*\) #\1/\2#' '
    if [ ! -e "$OUTF" ] ; then
        moodbar -o "$OUTF" "$i"
    fi
```

126
7.1.5 Troubleshooting

- If the Moodbar executable gives you a *bus error*, that almost always means it can’t decode (or can’t find) your file. Take a look at the supported file types below for ideas on which GStreamer plugins to install. You can also try the command below to test whether GStreamer can decode your file:

  \[
  \texttt{gst-launch-1.0\ filesrc\ location=[file]\ !\ decodebin\ !\ fakesink}
  \]

- If you are using the ffmpeg plugin to decode mp3s, you may also receive mysterious bus errors. The solution is to stop using the ffmpeg plugin, as it is extremely buggy — use mad instead.

- If the Moodbar executable tells you that it can’t find an element — i.e., it gives an error message like

  \[
  \text{Could not create element of type fftwspectrum, please install it.}
  \]

  — that usually means that you either don’t have the required plugins installed (see the plugin list [here](#)), or that you didn’t install the Moodbar package in the same prefix as GStreamer. If libmoodbar.so and libgstdecodebin.so are not in the same directory, then Moodbar is not installed in the same prefix as GStreamer. Please read the INSTALL file for instructions on how to configure the moodbar package correctly. Alternatively, if you know what you’re doing, it may be easier for you to take a look at the `GST_PLUGIN_PATH` environment variable.

- If you’re wondering why the Moodbar isn’t working, either not working at all or not working for a particular file, run the command below, where `file` is a music file:

  \[
  \texttt{moodbar\ -o\ test.mood\ file}
  \]

  To generate a test image preview, one can use the command:

  \[
  \texttt{gst-launch-1.0\ filesrc\ location=[file]\ !\ decodebin\ !\ audioconvert\ !\ fttwspectrum\ !\ moodbar\ height=50\ max-width=300\ !\ pngenc\ !\ filesink\ location=mood.png}
  \]

- If you have multiple versions of GStreamer installed, make sure all of the required plugins are installed for version 1.0.* — different versions *cannot* use each other’s plugins.

7.1.6 Supported Filetypes

You will need various Gstreamer plugins to enable Moodbar to analyze your files. Here is a list of the plugins you will need; make sure to install the 1.0.* version of each plugin:

<table>
<thead>
<tr>
<th>Filetype</th>
<th>Required Plugin</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>gstreamer-1.0.*, gstreamer-plugins-base, gstreamer-plugins-good</td>
<td></td>
</tr>
<tr>
<td>mp3</td>
<td>gst-plugins-mad (in gstreamer-plugins-ugly)</td>
<td>ffmpeg plugin has problems; do not use for mp3</td>
</tr>
<tr>
<td>ogg</td>
<td>gstreamer-plugins-vorbis, gstreamer-plugins-ogg</td>
<td></td>
</tr>
<tr>
<td>flac</td>
<td>gstreamer-plugins-flac</td>
<td></td>
</tr>
<tr>
<td>mp4</td>
<td>gstreamer-plugins-faad, gstreamer-plugins-bad</td>
<td></td>
</tr>
<tr>
<td>musepack</td>
<td>gstreamer-plugins-musepack</td>
<td></td>
</tr>
<tr>
<td>wma</td>
<td>gstreamer-plugins-wma</td>
<td></td>
</tr>
</tbody>
</table>
7.1.7 Screenshots

Moodbar in progress slider in Amarok 2

7.2 Replay Gain

Replay gain will automatically adjust the volume of the currently played song, relative to other songs, as determined by the person who encoded the audio file. To enable replay gain, see Settings menu.

To handle this, Amarok relies on metadata embedded in the audio file:

1. If no replay gain information is embedded, Amarok will not adjust the volume
2. If replay gain information is found, it will be written into Amarok’s database

During playback, Amarok will only look into its own database for this information. Updates to the metadata of the file will not always get written into the database during a collection update (e.g. replay gain is deleted from file).

This can lead to unexpected behavior: Songs from the same artist play at different volume levels etc.

7.2.1 Is replay gain being used?

To figure out if the volume problem is caused by replay gain or bad encoding:

- Disable replay gain processing (see above)
- Start Amarok in debug mode and search for gain-related output:

```
amarok -d --nofork | grep gain
```

If replay gain is active for the played song, the output will be

Using gain of -10.28 with relative peak of -1

7.2.2 View replay gain information

For .flac files, ‘metaflac’ can be used to view embedded replay gain data:

```
metaflac --list Millencolin\ Balanced\ Boy.flac
```

Among other things, this will show something like this:
To view this tracks information within the Amarok database:

```
select id, title, albumgain, albumpeakgain, trackgain, trackpeakgain
from tracks where title like "Balanced%";
```

Will show:

<table>
<thead>
<tr>
<th>id</th>
<th>title</th>
<th>albumgain</th>
<th>albumpeakgain</th>
<th>trackgain</th>
<th>trackpeakgain</th>
</tr>
</thead>
<tbody>
<tr>
<td>10459</td>
<td>Balanced Boy</td>
<td>0.53</td>
<td>-5.60297</td>
<td>0.44</td>
<td>-5.60297</td>
</tr>
</tbody>
</table>

Note the difference in loudness levels

### 7.2.3 Delete replay gain information

First, delete the metadata from the file:

```
metaflac --remove-replay-gain Millencolin\ -\ Balanced\ Boy.flac
```

After that, update your Amarok collection. If it is still using replay gain, update the database entry:

```
update tracks set albumgain=-1,albumpeakgain=-1,trackgain=-1,trackpeakgain=-1 where id=10459
```

Restart Amarok and the log output should now show the updated values being used.

Feel free to try and mess with the values manually to improve volume levels.

### 7.3 Amarok on other platforms

Amarok is intended for the KDE desktop, but it works on other platforms as well. Although it takes some effort, Amarok can run on these configurations:

---

Non-KDE Desktops
7.3.1 Amarok on Non-KDE Desktops

Although Amarok is one of the most well-known KDE applications, it can run on other desktop environments too.

This section shows how Amarok can be used on non-KDE Linux® desktops. These are examples; there may be more.

7.3.1.1 GNOME

To configure the proxy for Amarok on GNOME, modify and add this to ~/.kde/share/config/kioslaverc

```
[Proxy Settings][$i]
ProxyType=1
httpProxy=http://username:password@proxyserver:port/
httpsProxy=http://username:password@proxyserver:port/
ftpProxy=http://username:password@proxyserver:port/
```
7.3.1.2 Enlightenment

The Amarok systray icon does not work by default with E17. So, one should disable the Show tray icon from General Options in Amarok’s preferences.

7.3.1.3 XFCE

To launch Amarok faster, enable Launch KDE services on startup by going into Settings → Sessions and Startup → Advanced and checking the option.
7.3.1.4 Fluxbox

If Amarok is taking too long to load, add `exec kdeinit` to 
`/tildelow/.fluxbox/startup`.

7.3.1.5 LXDE

In case Amarok starts slowly in LXDE, you can add `kdeinit` to the startup applications using the `lxsession-edit` command.

7.3.2 Amarok on Windows
As you already know, a normal Windows install doesn’t use KDE, so if you want to install Amarok, you can’t just download the Amarok package. You must install a compatible compiler first. Here is described how to download, install and run Amarok in the Windows operating system.

7.3.2.1 How to download

If you run into any difficulties, please visit the Amarok on Windows wiki page where the latest links will be kept updated. Otherwise, use the latest at the following links:

7.3.2.2 How to install

The installation is very simple, just run the downloaded .exe file.

WARNING
If you want to update be sure to remove your current install.

7.3.2.2.1 Step 1

First, review on the license terms.

7.3.2.2.2 Step 2

Second, choose the install location.
If you want to change the default location, select Browse... and choose a new location.
7.3.2.2.3 Step 3
Wait a few minutes while the installation finishes.

7.3.2.2.4 Step 4
When the installation is done, dismiss the window with Close. Your Amarok installation has finished.
7.3.2.3 Running Amarok

When the installation finishes, you’ll find an Amarok shortcut on your desktop. To run Amarok, just click the shortcut.

7.3.3 Amarok on Mac®OS X

**WARNING**
Current Macports 2.1.3 only ships an outdated Amarok 2.6.0 version

Amarok can be installed and used on the Mac® OS X.

7.3.3.1 Installation using MacPorts

To install Amarok on Mac® OS X, first one needs to install MacPorts from here. Once MacPorts is installed one needs to run the following command in the terminal:

```
sudo port install amarok
```
The **port** command will fetch all the dependencies, compile, build and install them. This process may take quite some time, four to five hours in a recent install.

### 7.3.3.2 Screenshots

The following screenshot shows Amarok running on the Mac® OS X:

![Terminal screenshot](image)

### 7.3.3.3 Other resources

If you run into difficulties, there is a troubleshooting page here.
7.4 Troubleshooting and Common Problems

If you work through the procedures here, but don’t have success, please come into IRC (irc://irc.libera.chat/amarok), post on the KDE Forum Amarok section, or write to the Amarok list.

7.4.1 Problems installing

7.4.1.1 Bad packaging

Occasionally, users will encounter bad packaging from the distributions; either from the wrong version of a component being included, or some needful part being left out. For some reason, this often happens with MySQL dependencies. Bug reports in these cases should be made to your distribution, not to bugs.kde.org.

7.4.1.2 Difficulties building from source

For those who wish to help out by testing the newest Amarok versions, a local build is advised. Use this excellent guide: Compiling Amarok from GIT Locally; a Full Summary. Detailed information about git can be found here: Techbase GIT Tutorial.

If you have built successfully before, and now are encountering errors, try removing CMakeCache.txt and try again. If that still errors out, remove the entire Build folder and build completely fresh.

The URL to pull from git has recently changed. Run git remote set-url origin git://anongit.kde.org/amarok if you still using the old URL. Please ping us if you find the old link in our documents so we can update it everywhere.

7.4.2 Problems starting up

7.4.2.1 Playlist errors

The current playlist can occasionally get corrupt, which will prevent Amarok from starting. This can be fixed by simply removing the current playlist file in the Amarok directory, $HOME/.kde/share/apps/amarok/current.xspf. Note that on some systems, this may be .kde4 rather than .kde.

7.4.2.2 Database issues

If the database is corrupt and this is preventing Amarok from starting, you can move the database to a backup location (or simply delete it). This will cause Amarok to rebuild the database from scratch. Move the $HOME/.kde/share/apps/amarok/mysqle folder to a backup location (such as $HOME/.kde/share/apps/amarok/mysqle/) and restart Amarok.

7.4.2.3 Other issues and backing up settings

If the above two items do not help, or you otherwise need to restore Amarok to a clean configuration, you can move to a backup location (or delete) the Amarok directory at $HOME/.kde/share/apps/amarok and the Amarok config files at $HOME/.kde/share/config/amarok* (there may be two or three files matching this pattern). Again, the directory may be .kde4 rather than .kde.
7.4.3 Problems Scanning, Sorting files

Amarok scans your music files on first startup, and will keep your collection up-to-date automatically, if you chose Settings → Configure Amarok → Collection → Watch folders for changes.

If you don’t want Amarok scanning for changes, uncheck that, and use Tools → Update Collection whenever you make changes to your collection.

More about Amarok collection scanning here.

7.4.3.1 Corrupt tags

Some folks notice that Amarok seems to be missing some files. One of the causes can be corrupt tags, which you can check using the tagging application kid3. More about tagging here.

To find the bad file(s), run amarokcollectionscanner from the console. Details here.

7.4.3.2 Inability to write tags

If Amarok is not saving changes to tags, you may have permissions problems. Ensure that your user has write permissions to your music. For example, chown -R youruser Music/ to change ownership to your user, or chmod -R +w Music/ to add write permissions to the owner.

7.4.3.3 Incorrect Sorting (Various Artists)

Sometimes people report that tracks are in Various Artists when they should not be, or are sorted into ‘Unknown Album.’ What separates Various Artists albums and tracks and albums sorted under their artists is the Album Artist tag. When you click Show under Various Artists in the context (right-click) menu, that tag will be emptied if it is filled. The opposite happens to a file in Various Artists when you choose Do not show under Various Artists, but the Album Artist tag will be auto-filled from the Artist tag.

If there is no Album tag, and no Album Artist tag, Amarok will put the track into Unknown Album in Various Artists. If you want them sorted otherwise, tag them the way you want them sorted. If you don’t know some of the information, try out the new MusicBrainz function in the tag editor, or use a tagging application.

7.4.3.4 Duplicate Tracks

Sometimes Amarok pops up following dialog during (perhaps initial) collection scan:

This most probably means that an identical file ended up twice in your collection at different places. You can use Amarok’s File Browser to check the files individually, usual action is to remove one of the duplicate files. If you are sure that the tracks are not (or shouldn’t be) duplicates, there may be several reasons why Amarok thinks they are:
The Amarok Handbook

1. The files are bit-by-bit identical
   - You can use for example `md5sum` command to verify that
   - You can edit metadata of one of the files from within Amarok File browser to differentiate them somehow, perhaps by editing (album) artist, year, composer or a comment

2. The files have the same Amarok AFT unique id
   - This is often a result of running `amarok_afttagger` and then creating multiple copies of a tagged file; tag reader such as Kid3 or MP3Diags can be used to verify this, look for Amarok 2 AFTv1 string in tags
   - You can use `amarok_afttagger` command-line utility to reset unique id of one of the tracks: `amarok_afttagger --newid --verbose path/to/one/of/the/tracks.mp3`
   - Alternatively, you can remove the unique id from one of the tracks, loosing the track-even-if-changed-from-outside functionality: `amarok_afttagger --delete --verbose path/to/one/of/the/tracks.mp3`

3. (for Amarok before v2.7.0-96-g216c18b) The files have the same MusicBrainz id
   - Released versions up to Amarok 2.7 treated MusizBrainz id embedded in tags (filled in by MusicBrainz-enabled tagger such as Picard) as unique identifiers of tracks. However, MusicBrainz changed the semantics of the id to mean 'recording id' since it was originally implemented in Amarok, which means that you may get false duplicates for example for tracks that appear on the original album and the Best of one. See bug #315329 for more info
   - You can use any advanced tag reader to verify this (look for MusicBrainz string in tags) and to remove the MusicBrainz id from one of the tracks
   - As an alternative solution, you can use `amarok_afttagger` to add Amarok AFT id to one of the tracks because Amarok will then prefer its own id rather than the MusicBrainz one: `amarok_afttagger --newid --verbose path/to/one/of/the/tracks.mp3`

7.4.4 Problems playing files

7.4.4.1 Amarok skips over tracks, or appears to play them without sound

If the files you are attempting to play are in mp3 format, please see instructions for enabling mp3 support on your distro, here. Note that one piece of software being able to play mp3s on your system does not necessarily mean Amarok has had the required codecs installed.

7.4.4.2 No sound, or bad sound

For more general sound issues, first check what Phonon backend you are using in **Settings → Configure Amarok → Playback → Configure Phonon → Backend**. Consider switching to a different backend; VLC and GStreamer backends should be available from your distribution. Both the Gstreamer or VLC backends are recommended, if your distribution is still shipping other backends do not use them.

Also check whether the backend standalone software can play the files correctly; if not this is an issue with that software and you may find information in their help files. In other words, can Gstreamer or VLC play the same file? Will it play in Dragon, which also uses phonon?

If it seems to be a PulseAudio problem, and you want to provide a log to the PulseAudio developers, the troubleshooting page is here.
7.4.5 Problems with collections on iPod etc.

7.4.5.1 Amarok show no cover-images or images are lost when transferring to device

Most likely the wrong version of libgpod4 is installed. On Debian and its derivatives like Kubuntu the default is libgpod4-nogtk, which comes without support for covers. Simply install the variant libgpod4: **sudo apt-get install libgpod4** The package libgpod4-nogtk can then be removed without problem. From Kubuntu Quantal Quetzal on (released as 12.10) this package has been removed and the default is libgpod4.

7.4.6 Crashes and bugs

- How to run Amarok from the command line: `amarok --debug --nofork`
- Amarok crashes, but Dr. Konqi doesn’t pop up — run in gdb with the following command: `gdb --args amarok --debug --nofork` In gdb’s console, type `run` to start Amarok, reproduce the crash, and then in gdb type `thread apply all bt` to generate the backtrace.
- Filing bugs: If triggered, Dr. Konqi will provide an option to report a bug and do most of the work for you. If not, you will need to submit the bug manually at bugs.kde.org. For crash bugs, paste the backtrace from gdb as a comment.
- How to get personal support with problems: IRC (#amarok on Libera Chat IRC), Forum, Mailing list

7.5 Frequently Asked Questions

7.5.1 What is Amarok?

Amarok is an audio player. More information can be found in a summary of its features and the screenshot gallery. To get started using Amarok, see the Quick Start Guide. The Amarok Handbook is here.

7.5.2 What are the differences between Amarok 2 and the previous versions?

Amarok 2 is a nearly complete code-rewrite so the codebase has little to do with Amarok 1.4. If you are missing a feature, please file a wish in Bugzilla.

Here you have a short list of some new features:

- Maybe the biggest new feature is the Service Framework, which integrates networked music sources directly into Amarok. This includes online music stores, media servers, Web music lockers, and more. Thanks to it you’ll get easy access to music provided by Magnatune, Jamendo, Last.fm, MP3Tunes Locker, Ampache and many others. Expect more big (and small) names to join during the 2.x lifecycle. See Internet Media Sources for more.

- Another exciting feature is the Context pane, occupying the central place of the Amarok’s window, replacing the old Context Browser from the 1.x series. It displays contextual information about the music you play, like the album cover, track rating, labels, lyrics, artist information, related songs and artists, guitar and bass tabs and others. Thanks to the Plasma technology it uses, the Context pane can provide very rich content, like AJAX, video and animations, all in an eye-catching fashion. More about the Context pane.
• To accompany the Context pane, we developed a new, space efficient playlist. In order to preserve horizontal space, it groups the track name, artist, album name and cover art together, and allows further grouping by album names. Plus you can rearrange it to your heart’s content! If you prefer the old 1.4 playlist, you can have that too. See Changing the Playlist layout for more.

• Another great gem is the video support. Watching your music videos inside Amarok feels great!

• We can’t forget the Dynamic Playlists, which extend the old Dynamic Playlists. They allow you to define an automatically populated playlist, based on specific probability driven criteria called ‘biases’. The Dynamic Playlists is joined by the new Automatic Playlist Generator, used to generate lists for specific purposes and of a specified length. See Dynamic Playlists and Automatic Playlist Generator for more information.

There are many more great features like advanced scripting, dynamic collections, usability improvements, improved media devices handling, a new podcast manager, support for more software platforms, and others.

7.5.3 Installation

7.5.3.1 Can I use Amarok without KDE?

Amarok requires parts of KDE to be installed to run, but will run fine in Gnome or other desktop environments, including Windows and OS X. For Amarok to run, kdelibs and kdebase-runtime need to be installed.

For some features to work correctly, such as the on-screen display, your window manager must be configured to support the relevant freedesktop.org standards. More about running Amarok on other platforms here.

7.5.3.2 Why does Amarok use KDElibs?

We are committed to supporting Amarok on all platforms. We use KDElibs and Qt because they provide an excellent development environment. Aside from Linux® and BSD, Amarok works on Windows and MacOS, and there are installers available, but unfortunately we don’t have (yet) the resources to offer full support for those operating systems. Almost all of our developers use free operating systems, and those have priority for us. We do however welcome Windows and OS X developers willing to help, and improve Amarok on those platforms.

7.5.4 General usage

7.5.4.1 How can I control Amarok from the keyboard?

Keyboard shortcuts are available; see our Keybinding Reference page for more information. To control Amarok from the console, type amarok --help-all for a current complete list of available control commands.

7.5.4.2 Where can I get support for Amarok?

There are several options. Often times problems you have with the initial install of Amarok are best answered by experts of your particular UNIX® or Linux® distribution. You may seek help from fellow users and developers at the Amarok forum and the Amarok IRC channel at irc.libera.chat channel #amarok.

Note that bugzilla is not a place to seek support. Please do enter a bug if you are serious about helping fix a bug in Amarok itself.
7.5.4.3 How do I report a bug?

If you find a bug in Amarok, please submit it to the KDE bugzilla instance. To make a complete bug report, please always include the following information:

• The exact Amarok version (the version can be found in Help → About Amarok). You should not report bugs for Amarok versions older than the current stable release as we do not provide backport fixes.

• The exact KDE and Qt version, even if you do not run Amarok in KDE (Help → About KDE)

• The exact Phonon backend. You can find this information in the Diagnostics (Help → Diagnostics)

• Whether the bug is reproducible. Please do not report bugs that you can not reproduce as these are almost impossible to fix.

• Exact steps how to reproduce the bug

If any of these information is missing the bug report is not complete. Please also be prepared to answer questions from the developers or bug triagers and eventually test other settings.

7.5.5 Questions about the Playlist

More about the Playlist here.

7.5.5.1 When I start Amarok, I see an empty playlist. How do I actually get tracks in there?

Use the Media Sources on the left side to navigate to the desired artist/album/track. Then drag the files into the Playlist part on the right. You can use Dynamic Playlists or the Automatic Playlist Generator to populate your playlist. You can also drag files in from any file manager, such as Dolphin. You may also double-click a track, artist or genre in your Media Sources or file-system, or right-click and Add to Playlist or Replace Playlist.

7.5.5.2 How do I remove tracks from the Playlist?

Select the track(s) you want to remove, and press the Delete key. Or right-click the selection and choose Remove From Playlist.

7.5.5.3 How can I load a playlist?

Just drag and drop the playlist file into the Playlist, like you would do with any other file. It’s that simple!

7.5.5.4 How can I save the current playlist?

Click the button in the Playlist toolbar. Slow-click the disc icon to chose to save to your harddisk, or to the database.
7.5.6 Playback Questions

7.5.6.1 How do I play audio CDs?

Audio CDs are treated differently than data CDs, which are also supported. When you insert an audio CD, it will be shown as a local collection. Drag to the playlist or Pop-Up Dropper, or right-click the selected tracks and choose Add to Playlist or Replace Playlist.

7.5.6.2 What media types does Amarok support?

Amarok does not play music by itself, but lets Phonon do that job, specifically the VLC or GStreamer backends of Phonon. Therefore, whatever files they can play, Amarok can play. To analyse file tags, Amarok uses Taglib, which supports most file types that contain metadata.

7.5.6.3 What is Phonon? What are Phonon backends?

Phonon is the multimedia framework of KDE 4. You can find more information here. We currently recommend both the Gstreamer and VLC backend as both are actively maintained. If you want to play streams you should use the VLC backend only as the Gstreamer backend has some shortcomings in this regard. Make sure you do not use any other backend as those are obsolete.

If you are using the Phonon-backend-gstreamer make sure you only use plugins from one single gstreamer version, else your sound will be compromised.

7.5.6.4 Amarok won’t play mp3s, what can I do?

You probably lack the codecs required by your particular Phonon backend (Gstreamer, or VLC). Please report this to your distribution if you were not prompted to install them automatically when you started Amarok for the first time.

7.5.6.5 I have the codecs, but Amarok still won’t play mp4s and mkas

When using some phonon backend, like the gstreamer one, Amarok might refuse to play mp4 and mka files. This is a known problem, see bug #290168 for more technical information.

A very simple workaround is to change the file extension. Change mp4 extension to m4a and for mka change it to mkv. Of course you must be sure the files contains audio only. You can use the ffmpeg command to look at what data streams are present in the file. If the file has a video stream it must be stripped out. There are a lot of tools able to edit these formats and most of them are based on ffmpeg/libav, which you can use if you are familiar with them. If you prefer graphical tools one possible choice is avidemux.

This is a quick example how you can remove a video stream from an mp4 video with ffmpeg. Stripping a video stream from an mkv file is the same. First check if there is a video stream

```
$ ffmpeg example.mp4 2>&1 | grep Video
```

If the output of the previous command is null there is no video stream in the file. To create an m4a file with just the audio stream you can use something like

```
ffmpeg -i example.mp4 -acodec copy -vn example.m4a
```
You can also use `avconv` in place of `ffmpeg` with the same options, where

- `-i example.mp4` option is the input file name
- `-acodec copy` is used to not encode again the audio stream but just copy it. This to avoid quality loss, but you can also encode in a different format if you want, and you are not forced to use m4a container in this case
- `-vn` strips the video stream
- `example.m4a` is the output file name

Another possible workaround is to change the phonon backend. For example the VLC backend doesn’t suffer this problem.

7.5.6.6 I have a second soundcard and I’m using ALSA. How do I make Amarok use it instead of the default?

Configure this in the Phonon system settings module. **Settings → Configure Amarok → Playback → Configure Phonon**

7.5.6.7 Where’s the equalizer?

The equalizer is only available if you are using the phonon-backend-gstreamer. You can find the equalizer in the **Tools** menu.

7.5.6.8 How can I control the volume in Amarok only without having to change in KMix?

Most distributions ship the PulseAudio sound-daemon nowadays which handles the sound settings system-wide. If you can’t change the volume in Amarok independently of KMix, then your PulseAudio settings have the option

```
flat-volume=yes
```

enabled. Depending on your distribution this is located either in the file `$HOME/.pulse/daemon.conf` or in the system file `/etc/pulse/daemon.conf`. More information about Pulseaudio-specific settings can be found in `pulse-daemon.conf` man page.

7.5.6.9 How do I turn on visualizations?

Visualizations come in the form of an applet. For more information please see the [applets page](#). Visualizations are currently under development and may be buggy at this time.

7.5.6.10 How can I add podcasts?

Go to **Podcast** section in the **Media Sources** pane and then select **Add Podcast...** Add the podcast URL where indicated. More about podcasts [here](#).

We also have some services, such as gpodder and Podcast Directory to help you find great podcasts. Enable services in the **Settings** menu: **Configure Amarok → Plugins**.

7.5.6.11 How can I use Amarok to stream to my own radio station?

If you want to stream directly to an icecast or shoutcast server the answer simply is: it is not supported. You could use **IDJC** for that.
7.5.7 Collection questions

7.5.7.1 Folder not properly picked up

If you find that most of your music is recognized by Amarok, but some folders are not properly picked up, open a console and type

touch folder

where *folder* is the path to the folder that has the problem. Then select Settings → Configure Amarok in Amarok main window menu, open Collection page and click the Full Rescan button. Your folder should be visible again now.

**Warning**

this will not work on Windows, as the touch command is specific to Linux® and BSD-like systems.

7.5.7.2 Can I use removable media inside Amarok?

Amarok has a greatly improved support for the media devices based on Solid, the KDE hardware layer, that doesn’t need a lot of configuration. You should be able to just plug in your device and access it within Amarok. Also, thanks to the Dynamic Collections, your media devices could become part of your music collection, and be searchable and accessible within the Local Music section of the Media Sources pane when it’s connected.

You can transfer your songs, albums and artists from your local collection by right-clicking, selecting Copy to Collection and picking your device; and you can also do it in the other way: right-click and select Copy to Collection → Local Collection. More about Amarok and devices here.

7.5.7.3 Can I use the old Amarok’s collection in Amarok 2? Will my tags, score are ratings be lost?

A database importer is available. You will be able to keep your ratings and statistics just fine. More here.

7.5.8 General questions

7.5.8.1 What are scripts?

They are little pieces of software that add some functions to Amarok. There are a lot of scripts, and you can find them in kde-apps.org or you can find and install them inside Amarok using the Script Manager. More details can be found here. You will find the Script Manager from the Settings menu, Configure Amarok → Scripts.

7.5.8.2 Can I use Amarok 1.4 scripts in Amarok 2?

No. A new and powerful scripting API has been created, which provides huge improvements but won’t let you use your old scripts. The new scripting system is based on QtScript and will significantly reduce Amarok’s dependencies, a huge problem for non-technical and cross-platform users, and will greatly reduce the amount of external processes launched at runtime. Another advantage is that the new API will allow much deeper integration with Amarok than the old scripting system. Amarok Scripting API.
7.5.8.3 What are Moodbars?

Moodbars show the mood of a song in the progress bar. More about Moodbar [here](#).

7.5.8.4 Can I play video files?

Amarok is mainly a music player so no video file management, collection support, DVD playback, subtitles, or any other sophisticated features are available.

7.5.8.5 Is it Amarok, AmaroK or amaroK?

It is Amarok! The former spelling was amaroK, but it was changed due to its strange look around 2005.

7.5.8.6 How are track scores determined?

Amarok assigns a score (a number 0-100) to a song based on how many times you’ve listened to it and whether you skip the song without it finishing. Every time the song finishes playing, the score is changed.

Here you have an example script that can calculate scores:

```plaintext
if( playcount <= 0 ) # not supposed to be less, but what the hell.
    newscore = ( prevscore + percentage ) / 2
else
    newscore = ( ( prevscore * playcount ) + percentage ) / ( playcount + 1 )
end
```

You can easily create your own script with your own algorithm. Look at the Script-Writing-Howto for further information.

7.5.8.7 How do I manually change a track’s score?

You may change the score manually in the Track Details dialog, available by right-clicking on a track, choosing Edit Track Details and going to the Summary tab.

7.5.8.8 But I also want that stars system like in other players!

Amarok, of course, supports a user-defined rating system, and you can rate your tracks with a single click using the Current Track applet. You can also do this in the context menu (right-click) Edit Track Details → Summary tab. If you have the rating stars displayed in your playlist layout, you can also edit there, with the slow double-click.

7.5.8.9 Can I drag and drop Plasma applets from the main window to the Desktop?

No, but there are several Plasmoids available for your Desktop, which will let you display information provided by Amarok as well as control Amarok.
7.5.8.10 How can I save a stream?

First of all, load the stream into the playlist. There are several ways to do this: downloading the file and opening it with Amarok; using the menu Playlist → Add stream; among others.

Once the stream is loaded, you can save it by clicking on in the Playlist pane, and giving it a meaningful name. The Stream will then be added to the Saved Playlists view for later reference.

7.5.8.11 Where do I find the settings for Amarok?

'kde4-config --localprefix'/share/apps/amarok
'kde4-config --localprefix'/share/config/amarokrc

7.5.9 Troubleshooting

7.5.9.1 How can I obtain a backtrace?

If Amarok has crashed and you want to report it, visit the Debugging HowTo. The bug report must be made in bugs.kde.org after verifying if it has not already been reported.

7.5.9.2 Amarok just freezes! How can I help get this fixed?

You can obtain a backtrace of a frozen instance of Amarok using gdb like so:

$ gdb -p 'pidof amarok' (gdb) thread apply full bt all

Then just post the backtrace to PasteBin, as described in the Debugging HowTo.

7.5.9.3 Amarok takes a lot of time to start

If this happens you have to check what scripts you have installed and what internet services are running, because some of them may slow down the startup. Also, if you have streams in the playlist when you open Amarok, the startup can take a little longer. The same happens if you have a great number of tracks in the playlist (over 300 and more).

On the other hand, if you don’t use KDE, but a different desktop environment, startup time can be increased very slightly because there are more libraries to be loaded.

7.5.10 Development questions

7.5.10.1 How do I get a GIT version of Amarok?

See the Amarok Development build instruction page. Check here for a local build: Building from Git Locally: Full Summary

7.5.10.2 Why isn’t Amarok part of KDE Multimedia?

Packages in the KDE Software Compilation proper have a release schedule that doesn’t fit with Amarok’s development pace, and since none of the other KDE applications depend on Amarok there is no need to follow this release schedule.
7.5.10.3  I've found a bug / I've got a great idea for Amarok!

Please report it at bugs.kde.org. If you have a list of suggestions or wishes it may be best to send them to our mailing list: amarok@kde.org. Simply posting the idea to our IRC channels or on an obscure wiki page or blog won’t help much as the information will get lost.

7.5.10.4  Do you accept patches?

Happily! Your best course of action is to let us know what you plan to do before you do any work so we can discuss it, but don’t fret; we haven’t turned down a patch yet! Discussion is mostly to help you patch the correct bits of Amarok. Submit your patches and code contributions to git.reviewboard.kde.org. See also How to Submit Patches to Amarok. If you have a bug fix then just go ahead; this is open source after all.

7.5.10.5  Why did you choose the name Amarok?

Amarok is an album by British composer Mike Oldfield. Project founder Mark Kretschmann happens to like it a lot, and he thought the name had a nice sound. Plus, of course, it contains the all important K.
Chapter 8

References

• Menu and Command Reference
  – Amarok Menu
  – View Menu
  – Playlist Menu
  – Tools Menu
  – Settings Menu
  – Help Menu
• Keybinding Reference
  – Global Shortcuts
  – Amarok Shortcuts
• Credits and License

8.1 Menu and Command Reference

8.1.1 Amarok Top-level Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amarok</td>
<td>Common actions such as Play, Pause, etc.</td>
</tr>
<tr>
<td>View</td>
<td>Change the layout of Amarok</td>
</tr>
<tr>
<td>Playlist</td>
<td>Configure your Playlist</td>
</tr>
<tr>
<td>Tools</td>
<td>Start additional tools and scripts</td>
</tr>
<tr>
<td>Settings</td>
<td>Change settings and configure Amarok</td>
</tr>
<tr>
<td>Help</td>
<td>Important information about Amarok and KDE</td>
</tr>
</tbody>
</table>
8.1.2 Amarok Menu

Some of the common actions in Amarok are here, mostly to control media playback.

8.1.3 Contents

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play Media...</td>
<td>Opens a media file to be played.</td>
<td>Ctrl-O</td>
</tr>
<tr>
<td>Previous Track</td>
<td>Skips back to the last track played within your current session.</td>
<td></td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Starts or temporarily stops the playing of the current media file.</td>
<td>Space</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops all playback in progress.</td>
<td></td>
</tr>
<tr>
<td>Stop after current Track</td>
<td>Waits until the current track ends before stopping the playback. This is useful when using a playlist.</td>
<td></td>
</tr>
<tr>
<td>Next Track</td>
<td>Skips playback to the next media file in your playlist.</td>
<td></td>
</tr>
<tr>
<td>Quit</td>
<td>Exits out of Amarok.</td>
<td>Ctrl-Q</td>
</tr>
</tbody>
</table>
8.2 View Menu

This top-level menu contains options to adjust the layout of Amarok, and a checkbox to lock the configuration; use this to prevent any accidental changes to the Amarok window layout.

8.2.1 Changing the Amarok Toolbar

There are also two radio buttons in this menu, which are used to choose which Toolbar Amarok will use. The **Main Toolbar** has a larger height and slightly different controls than the **Slim Toolbar**. The **Main Toolbar** contains two main control buttons: a Play / Pause button and a button for controlling the volume. It also displays the name of the current media file and a slider for showing, as well as changing, the position of playback. More about the **Toolbar**.

8.2.2 Amarok Window Layouts

If the **Lock Layout** button is unchecked, the **Media Sources**, **Context** and **Playlist** tabs can be toggled and many layouts can be created as shown below:
8.2.3 Playlist Menu

This is a top-level drop down menu where can configure your Playlist. From here you can add more tracks, streaming radio channels, and clean your playlist.

8.2.3.1 Menu Items
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Media...</td>
<td>Opens a media file to be played in Amarok</td>
<td></td>
</tr>
<tr>
<td>Add Stream...</td>
<td>Choose different streaming radio channels using the URL bar, by pasting or typing the link</td>
<td></td>
</tr>
<tr>
<td>Export Playlist As...</td>
<td>Save your favorite playlists in various formats - mp3 streaming, Shoutcast, xspf</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Go one step backward</td>
<td>Ctrl-Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Click ‘Redo’ to do the last step over again</td>
<td>Ctrl-Shift-Z</td>
</tr>
<tr>
<td>Clear PlayList</td>
<td>Cleans the current playlist</td>
<td></td>
</tr>
<tr>
<td>Remove Duplicates</td>
<td>Removes duplicate entries in the playlist</td>
<td></td>
</tr>
<tr>
<td>Playlist Layouts</td>
<td>Changes the visual style of the Playlist</td>
<td></td>
</tr>
<tr>
<td>Edit Queue</td>
<td>Allows you to change the order of your queue</td>
<td></td>
</tr>
</tbody>
</table>

8.2.3.2 Playlist Layouts

From Playlist → Playlist Layouts switch between different layouts with radio buttons, and configure your personal Playlist layout.

8.2.3.2.1 Default

Playlist → Playlist Layouts → Default
8.2.3.2.2 No Grouping

Playlist → Playlist Layouts → No Grouping
8.2.3.2.3 No Grouping (Single line)

Playlist → Playlist Layouts → No Grouping(Single line)
8.2.3.2.4  Verbose

Playlist → Playlist Layouts → Verbose
8.2.3.2.5 Configure playlist layout...

Playlist → Playlist Layouts → Configure playlist layout...

This option allows you to make your own Playlist layout; display Artist, Genre, Year, BPM and so forth.

8.2.4 Tools Menu

From this menu you can use additional tools and scripts.
The Amarok Handbook

The Tools Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark Manager</td>
<td>Allows you to save bookmarks of various types.</td>
</tr>
<tr>
<td>Cover Manager</td>
<td>Allows you to view album covers and fetch missing ones.</td>
</tr>
<tr>
<td>Equalizer</td>
<td>Shows the equalizer.</td>
</tr>
<tr>
<td>Network Request Viewer</td>
<td>Shows the Network Requests Viewer.</td>
</tr>
<tr>
<td>Update Collection</td>
<td>Checks the tracks in your collection and updates the database.</td>
</tr>
<tr>
<td>Synchronize Statistics</td>
<td>Opens the Statistics Synchronization dialog.</td>
</tr>
</tbody>
</table>

8.2.4.1 Bookmark Manager

The bookmark manager allows you to bookmark different kinds of things to recall them later. You can also create folders to organize your collection of bookmarks. The search box provides a convenient way to find bookmarks. The context menu offers the possibility to **Load** and **Delete** the bookmark.

![Bookmark Manager](image)

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark Context View Applets</td>
<td>Saves the currently used view applets.</td>
</tr>
<tr>
<td>Bookmark Media Source View</td>
<td>Saves the current view of the media source tree.</td>
</tr>
<tr>
<td>Bookmark Playlist Setup</td>
<td>Saves the current playlist setup.</td>
</tr>
<tr>
<td>Bookmark Track Position</td>
<td>Saves the position in the current track.</td>
</tr>
</tbody>
</table>
8.2.4.2 Cover Manager

Shows all albums in your collection. Here you can set custom album covers and fetch missing ones. More about the Cover Manager, shown below.

8.2.4.3 Equalizer

Provides the possibility to configure sound settings. You can choose between manually adjusting the settings and using templates. Right now, the Phonon GStreamer is required for a functional equalizer.
8.2.4.4 Network Requests Viewer

The Network Requests Viewer allows you to monitor the network requests made by Amarok. Selecting this option will open this window:

![Network Requests Viewer Window](image)

8.2.4.5 Update Collection

Checks the files in the folders you defined as your collection. New files will be added and missing ones removed from the left pane.

8.2.4.6 Synchronize Statistics

This option allows you to synchronize statistics of your various collections. This is a new feature in Amarok since version 2.7 For more information, see also Statistics Synchronization Between Collections and with Last.fm in the handbook.

8.2.5 Settings Menu

Here is where you change settings and configure Amarok.
The Amarok Handbook

The Amarok Settings Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Menubar</td>
<td>Hide the menu bar. Show it again by pressing Ctrl-M</td>
</tr>
<tr>
<td>Replay Gain Mode</td>
<td>Allows you to set the Replay Gain mode; Off, by Track, or by Album</td>
</tr>
<tr>
<td>Configure Shortcuts...</td>
<td>Allows you to make custom keyboard shortcuts</td>
</tr>
<tr>
<td>Configure Amarok...</td>
<td>Configure General options, Internet Services, Playback, Notifications, and Database</td>
</tr>
</tbody>
</table>

8.2.5.1 Show Menubar

Clicking this option will hide the menu bar. The only way to show the menu bar again is by pressing Ctrl-M, because you can’t de-select the menu option when no menu bar is shown. More about the Menus in the Menubar.

8.2.5.2 Replay Gain Mode

The replay gain mode will change the volume depending on meta information of the track. More about replay gain: Wikipedia entry for replay gain.

You can switch the replay gain mechanism off, use a track-based or the album-based replay gain.

8.2.5.3 Configure Shortcuts...

Change and define new keyboard shortcuts, or turn on multimedia keys if your keyboard has them. More about Shortcuts.
8.2.5.4 Configure Amarok...

Configure many aspects of Amarok. Details in Configuring Amarok.

8.2.6 Help Menu

Important information about Amarok and KDE.
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Bug...</td>
<td>Report bugs to the bug tracker directly, with much of your information automatically supplied to the database form.</td>
</tr>
<tr>
<td>Amarok Handbook</td>
<td>This Handbook in Docbook format.</td>
</tr>
<tr>
<td>Send a Comment to the Developers</td>
<td>Send a brief comment to Amarok developers. Do NOT use to send bug reports.</td>
</tr>
<tr>
<td>Show Feedback Icons</td>
<td>Check to show feedback icons on every Amarok screen and sub-menu.</td>
</tr>
<tr>
<td>Switch Application Language...</td>
<td>Change Amarok menus and label language or back-up language.</td>
</tr>
<tr>
<td>About Amarok</td>
<td>Amarok version, web site, contributors and donors.</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Displays complete information necessary for filing good bug reports, such as Amarok Version, KDE, Qt, Phonon, and Phonon Backend versions, and whether or not PulseAudio is installed, as well as what Amarok Scripts are installed, and whether or not they are running. There is a button on the bottom to copy the information to the clipboard.</td>
</tr>
<tr>
<td>About KDE</td>
<td>Information about KDE, and links to join and support KDE.</td>
</tr>
</tbody>
</table>
Chapter 9

Keybinding Reference

9.1 Keyboard Shortcuts

Keyboard shortcuts let you quickly access Amarok’s power. Change the shortcuts using Settings → Configure Shortcuts.

Shortcuts are divided into two groups:

- Global Shortcuts
- Amarok Shortcuts

9.2 Control from Console

To control Amarok from the console, type `amarok --help-all` for a current complete list of available commands.

9.2.1 KDE Global Shortcuts

*Global Shortcuts* are KDE’s control key combinations. Use them to control Amarok from the keyboard as an alternative to using the mouse.

9.2.1.1 Default Global Shortcuts
### 9.2.2 Amarok Shortcuts

Control Amarok using *keyboard shortcuts*, which are combinations of keys which each control a specific action. Amarok has default shortcuts, but you can also make your own.

#### 9.2.2.1 Default Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Media...</td>
<td>Meta-A</td>
</tr>
<tr>
<td>Decrease Volume</td>
<td>Meta-</td>
</tr>
<tr>
<td>Increase Volume</td>
<td>Meta+</td>
</tr>
<tr>
<td>Last.fm: Love Current Track</td>
<td>Meta-L</td>
</tr>
<tr>
<td>Last.fm: Skip Current Track</td>
<td>Meta-S</td>
</tr>
<tr>
<td>Mute Volume</td>
<td>Meta-M</td>
</tr>
<tr>
<td>Next Track</td>
<td>Media Next</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Media Play</td>
</tr>
<tr>
<td>Stop</td>
<td>Media Stop</td>
</tr>
<tr>
<td>Previous Track</td>
<td>Media Previous</td>
</tr>
<tr>
<td>Rate Current Track: 1 star</td>
<td>Meta-1</td>
</tr>
<tr>
<td>Rate Current Track: 2 stars</td>
<td>Meta-2</td>
</tr>
<tr>
<td>Rate Current Track: 3 stars</td>
<td>Meta-3</td>
</tr>
<tr>
<td>Rate Current Track: 4 stars</td>
<td>Meta-4</td>
</tr>
<tr>
<td>Rate Current Track: 5 stars</td>
<td>Meta-5</td>
</tr>
<tr>
<td>Seek Backward</td>
<td>Meta-Shift-</td>
</tr>
<tr>
<td>Seek Forward</td>
<td>Meta-Shift+</td>
</tr>
<tr>
<td>Show Notification Popup</td>
<td>Meta-O</td>
</tr>
<tr>
<td>Toggle Main Window</td>
<td>Meta-P</td>
</tr>
<tr>
<td>Increase Volume</td>
<td>+</td>
</tr>
<tr>
<td>Decrease Volume</td>
<td>-</td>
</tr>
<tr>
<td>Edit Details of Currently Selected Track</td>
<td>Ctrl-E</td>
</tr>
<tr>
<td>Search in Playlist</td>
<td>Ctrl-J</td>
</tr>
<tr>
<td>Shuffle Playlist</td>
<td>Ctrl-H</td>
</tr>
<tr>
<td>Play Media...</td>
<td>Ctrl-O</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Space</td>
</tr>
<tr>
<td>Previous Browser</td>
<td>Backspace</td>
</tr>
<tr>
<td>Copy the Currently Playing Artist and Title to</td>
<td>Ctrl-C</td>
</tr>
<tr>
<td>the Clipboard</td>
<td></td>
</tr>
<tr>
<td>Queue Track</td>
<td>Ctrl-D</td>
</tr>
<tr>
<td>Quit</td>
<td>Ctrl-Q</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl-Shift-Z</td>
</tr>
<tr>
<td>Seek Forward By 2 seconds*</td>
<td>Ctrl-Right</td>
</tr>
<tr>
<td>Seek Forward By 10 seconds*</td>
<td>Right</td>
</tr>
<tr>
<td>Seek Forward By 60 seconds*</td>
<td>Shift-Right</td>
</tr>
<tr>
<td>Seek Backward By 2 seconds*</td>
<td>Ctrl-Left</td>
</tr>
<tr>
<td>Seek Backward By 10 seconds*</td>
<td>Left</td>
</tr>
<tr>
<td>Seek Backward by 60 seconds*</td>
<td>Shift-Left</td>
</tr>
<tr>
<td>Activate Search Bar</td>
<td>Ctrl-F</td>
</tr>
</tbody>
</table>
9.2.2.2 How to make shortcuts

You can configure shortcuts from Settings → Configure Shortcuts... where you can change or make new shortcuts.

9.2.3 How to use Configure Shortcuts...
The Amarok Handbook

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Search Actions and Shortcuts.</td>
</tr>
<tr>
<td>Details</td>
<td>Add, remove and get more information about shortcut schemes.</td>
</tr>
<tr>
<td>Reset to Defaults</td>
<td>Reset all custom shortcuts back to default.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the list of shortcuts.</td>
</tr>
<tr>
<td>OK</td>
<td>Save all changes.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close window without saving changes.</td>
</tr>
</tbody>
</table>

When you select an action, that opens a sub-window where you can choose between two radio buttons, Default and Custom. If you choose Default you’ll use the default shortcut. If you choose Custom you’ll configure and use your shortcut for this action.
Chapter 10

Credits and License

10.1 Program copyright

Copyright 2002, 2003 Mark Kretschmann (kretschmann kde.org).

10.2 Documentation copyright

NOTE
Please add your name here if you contribute to the handbook. Please respect alphabetical order

Abhishek Rane (abhishektux gmail.com)
Adrián Chaves Fernández (adriyetichaves gmail.com)
Caleb Bryant (c.bryant.30 gmail.com)
Daniel Marth (danielmarth gmx.at)
Dima Panov (fluffy freebsd.org)
Dion Moult ()
Emilio Castro González (periliocastrol gmail.com)
eqisow ()
Geoffry Song (goffrie gmail.com)
Jeff Mitchell (mitchell kde.org)
José Antonio Rey (joseeantonior ubuntu.com)
Lydia Pintscher (lydia kde.org)
Mayank Madan (mayankmadan live.com)
Myriam Schweingruber (myriam kde.org)
Nick Adams (runey676 gmail.com)
Paul Ivan (bit.alex001 gmail.com)
The Amarok Handbook

Pedro Raimundo (pedrooraimundo gmail.com)
Pete Daniels (pete guerrillatechsupport.com), screenshots
Salma Sultana (salma4534 yahoo.com)
Sash Karttunen (sasu.karttunen tpnet.fi)
tris r ()
Valorie Zimmerman (valorie.zimmerman gmail.com)
Walter P. Little (walterplittle gmail.com)
Willem Ferguson (willemferguson zoology.up.ac.za)

10.3 Licenses

This documentation is licensed under the terms of the GNU Free Documentation License. This program is licensed under the terms of the GNU General Public License. This documentation is licensed under the terms of the GNU Free Documentation License.